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 Important Information

Warranty
The NI-ELVIS hardware is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as 
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warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In 
the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document 
without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National 
Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL 
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING 
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of 
the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against 
National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service 
failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the 
product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside 
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
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Patents
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Conventions

The following conventions are used in this manual:

<> Angle brackets that contain numbers separated by an ellipsis represent a 

range of values associated with a bit or signal name—for example, 

AO <3..0>.

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash. When this icon is marked on the 

product, refer to the Read Me First: Safety and Radio-Frequency 

Interference document, shipped with the product, for precautions to take.

When symbol is marked on a product, it denotes a warning advising you to 

take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be 

hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names.

DAQ device DAQ device refers to any National Instrument DAQ device that meets the 

conditions listed in Chapter 3, Hardware Overview.

ELVIS Educational Laboratory Virtual Instrumentation Suite.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 

to a key concept. Italic text also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames, and extensions.
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1
DAQ System Overview

The NI ELVIS Hardware User Manual contains information that you

need to understand and program the National Instruments Educational 

Laboratory Virtual Instrumentation Suite (NI ELVIS) architecture and 

instruments. It also discusses the concept of virtual instrumentation and the 

components of an NI data acquisition (DAQ) system.

This chapter briefly describes the concept of DAQ systems and introduces 

NI ELVIS, a DAQ system designed for educational laboratories.

Note Refer to the Where to Start with NI ELVIS document for information about how to 

set up the components of the NI ELVIS.

What is Virtual Instrumentation?

Virtual instrumentation is defined as the combination of measurement 

and control hardware and application software with industry-standard 

computer technology to create user-defined instrumentation systems.

Virtual instrumentation provides an ideal platform for developing 

instructional curriculum and conducting scientific research. In an 

instructional laboratory course, students perform various experiments that 

combine measurements, automation, and control. Tools or systems used in 

these situations must be flexible and adaptable. In research environments, 

virtual instrumentation provides the flexibility that a researcher must have 

to modify the system to meet unpredictable needs. Research and 

instructional efforts also require that their systems be economical. Because 

you can reuse components in a virtual instrumentation system (without 

purchasing additional hardware or software), virtual instrumentation is an 

economical choice. Finally, measurement systems must be scalable to meet 

future expansion needs. The modular nature of virtual instrumentation 

makes it easy for you to add new functionality.

NI ELVIS uses LabVIEW-based software and NI data acquisition 

hardware to create a virtual instrumentation system that provides the 

functionality of a suite of instruments.
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What is DAQ?

DAQ systems capture, measure, and analyze physical phenomena from the 

real world. Light, temperature, pressure, and torque are examples of the 

different types of signals that a DAQ system can measure. Data acquisition 

is the process of collecting and measuring electrical signals from 

transducers and test probes or fixtures, and sending them to a computer for 

processing. Data acquisition can also include the output of analog or digital 

control signals.

The building blocks of a DAQ system include the following items:

• Transducer—A device that converts a physical phenomenon such as 

light, temperature, pressure, or sound into a measurable electrical 

signal such as voltage or current.

• Signal—The output of the DAQ system transducer.

• Signal conditioning—Hardware that you can connect to the 

DAQ device to make the signal suitable for measurement or to improve 

accuracy or reduce noise. The most common types of signal 

conditioning include amplification, excitation, linearization, isolation, 

and filtering.

• DAQ hardware—Hardware used to acquire, measure, and 

analyze data.

• Software—NI application software is designed to help you easily 

design and program measurement and control applications.
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Figure 1-1 shows the components of a typical DAQ system.

Figure 1-1.  Typical DAQ System

DAQ Hardware
The DAQ Hardware section of Chapter 3, Hardware Overview, describes 

in greater detail the DAQ device used as part of the NI ELVIS. Refer to the 

DAQ device documentation, available at ni.com/manuals for specific 

information about the functionality and operation of the device.

DAQ Software
The following sections describe the LabVIEW and SignalExpress software 

you can use with NI ELVIS.

LabVIEW
LabVIEW is a graphical programming language frequently used for 

creating test, measurement, and automation applications. LabVIEW uses 

icons instead of lines of text to create applications. Unlike text-based 

programming languages, LabVIEW uses dataflow programming, where 

the flow of data determines execution. A virtual instrument (VI) is a 

LabVIEW program that models the appearance and function of a physical 

instrument.
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The flexibility, modular nature, and ease-of-use programming possible 

with LabVIEW makes it popular in top university laboratories. With 

LabVIEW, you can rapidly create applications using intuitive graphical 

development and add user interfaces for interactive control. Scientists and 

engineers can use the straightforward I/O functionality of LabVIEW along 

with its analysis capabilities. You can also use LabVIEW in the classroom 

to solve purely analytical or numerical problems.

For more information about programming with LabVIEW, refer to Getting 

Started with LabVIEW and LabVIEW Fundamentals, available at ni.com/

manuals. The LabVIEW Help is available by selecting Help»Search the 

LabVIEW Help from the LabVIEW block diagram or front panel.

SignalExpress
SignalExpress is an interactive, standalone nonprogramming tool for 

making measurements. You can use SignalExpress interactively for the 

following:

• Acquiring, generating, analyzing, comparing, importing, and saving 

signals.

• Comparing design data with measurement data in one step.

• Extending the functionality of SignalExpress by importing a custom 

VI created in LabVIEW or by converting a SignalExpress project to a 

LabVIEW program so you can continue development in the LabVIEW 

environment.

For more information about SignalExpress, refer to Getting Started with 

SignalExpress, available at ni.com/manuals, and the NI Express 

Workbench Help, available by selecting Help»Express Workbench Help 

from the SignalExpress window.
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NI ELVIS Overview

NI ELVIS uses LabVIEW-based software instruments, a multifunction 

DAQ device, and a custom-designed benchtop workstation and prototyping 

board to provide the functionality of a suite of common laboratory 

instruments.

The NI ELVIS hardware provides a function generator and variable power 

supplies from the benchtop workstation. The NI ELVIS Traditional 

LabVIEW soft front panel (SFP) instruments combined with the 

functionality of the DAQ device and the NI ELVIS workstation provide 

the functionality of the following SFP instruments:

• Arbitrary Waveform Generator (ARB)

• Bode Analyzer

• Digital Bus Reader

• Digital Bus Writer

• Digital Multimeter (DMM)

• Dynamic Signal Analyzer (DSA)

• Function Generator (FGEN)

• Impedance Analyzer

• Oscilloscope (Scope)

• Two-Wire Current Voltage Analyzer

• Three-Wire Current Voltage Analyzer

• Variable Power Supplies

In addition to the SFP instruments, NI ELVIS Traditional has a set of 

high-level LabVIEW functions, which you can use to customize your 

display and experiments, to control the NI ELVIS workstation from 

LabVIEW.

With NI ELVIS Traditional 3.0 and later, you can control the NI ELVIS 

instruments in a nonprogramming environment with SignalExpress. In 

addition to the NI ELVIS instruments, you can also use the general AI, AO, 

DIO, and CTR functionality available on the NI ELVIS hardware in 

SignalExpress.

Refer to Figure 2-1, Parts Locator Diagram for Desktop NI ELVIS 

Systems, for an illustration of NI ELVIS.
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Related Documentation

The following documents contain information that you might find helpful 

as you read this manual:

• DAQ device documentation.

• Getting Started with LabVIEW.

• LabVIEW Help, available by selecting Help»VI, Function, and 

How-To Help from the LabVIEW block diagram or front panel.

• LabVIEW Fundamentals.

• Measurement & Automation Explorer Help for DAQmx, available by 

selecting Help»Help Topics»NI-DAQmx from the Measurement & 

Automation Explorer (MAX) window.

• Where to Start with NI ELVIS, available in PDF format on the 

NI ELVIS Traditional software media.

• NI ELVIS Traditional Help, available on the NI ELVIS Traditional 

software media.

• Getting Started with SignalExpress.

• NI Express Workbench Help, available by selecting Help»Express 

Workbench Help from the SignalExpress window.

• ni.com/academic for various academic resources.

You can download NI documents from ni.com/manuals.
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2
NI ELVIS Overview

NI ELVIS combines hardware and software into one complete laboratory 

suite. This chapter provides an overview of the hardware and software 

components of the NI ELVIS. Additionally, this chapter discusses how you 

can use NI ELVIS in various academic environments.

Chapter 3, Hardware Overview, provides more detailed information about 

NI ELVIS hardware components. Refer to the NI ELVIS Traditional Help 

for more information about the software components.

Refer to Figures 2-1 and 2-2 for a diagram of the NI ELVIS systems.

Figure 2-1.  Parts Locator Diagram for Desktop NI ELVIS Systems

1 Desktop Computer
2 68-Pin M Series DAQ Device

3 Shielded Cable to M Series Device
4 NI ELVIS Benchtop Workstation

1
2

4

3
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Figure 2-2.  Parts Locator Diagram for USB NI ELVIS Systems

NI ELVIS Hardware

The following sections briefly describe the hardware components of 

NI ELVIS. For more specific information about these components, refer 

to Chapter 3, Hardware Overview.

NI ELVIS Benchtop Workstation
Together, the benchtop workstation and the DAQ device create a complete 

laboratory system. The workstation provides connectivity and 

functionality. The workstation control panel provides easy-to-operate 

knobs for the function generator and variable power supplies, and it offers 

convenient connectivity in the form of BNC and banana-style connectors 

1 Laptop Computer
2 USB Cable
3 NI USB M Series with Mass Termination Device

4 NI USB M Series Device Power Cord
5 Shielded Cable to M Series Device
6 NI ELVIS Benchtop Workstation

1
3

6

4

5

2
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to the NI ELVIS Traditional - Scope and NI ELVIS Traditional - DMM. 

The NI ELVIS Traditional software routes signals in the NI ELVIS 

Benchtop Workstation between the SFP instruments. For example, you can 

route the output of the function generator to a specific channel of the DAQ 

device and ultimately acquire data on a desired channel of the 

NI ELVIS Traditional - Scope. The benchtop workstation also contains a 

protection board that protects the DAQ device from possible damage 

resulting from laboratory errors.

Refer to the NI ELVIS Benchtop Workstation section of Chapter 3, 

Hardware Overview, for more detailed information about the benchtop 

workstation, including the parts locator diagram.

NI ELVIS Prototyping Board
The NI ELVIS Prototyping Board connects to the benchtop workstation. 

The prototyping board provides an area for building electronic circuitry 

and allows the connections necessary to access signals for common 

applications. You can use multiple prototyping boards interchangeably 

with the NI ELVIS Benchtop Workstation.

Refer to the NI ELVIS Prototyping Board section of Chapter 3, Hardware 

Overview, for more information about the prototyping board, including 

signal descriptions, connection instructions, and the parts locator diagram.

NI ELVIS Traditional Software

The NI ELVIS Traditional software, created in LabVIEW, takes advantage 

of the capabilities of virtual instrumentation. The software includes SFP 

instruments, the LabVIEW API, and SignalExpress blocks for 

programming the NI ELVIS hardware.

SFP Instruments
NI ELVIS Traditional ships with the SFP instruments, created in 

LabVIEW, and the source code for the instruments. You cannot directly 

modify the executable files, but you can modify or enhance the 

functionality of these instruments by modifying the LabVIEW code. The 

instruments are virtual instruments (VIs) that are necessary in typical 

laboratory applications.

Note For a detailed explanation of the SFP instruments and instructions for taking a 

measurement with each instrument, refer to the NI ELVIS Traditional Help.
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Instrument Launcher
The NI ELVIS Traditional Instrument Launcher provides access to the 

NI ELVIS Traditional SFP instruments. Launch the NI ELVIS Traditional 

Instrument Launcher by double-clicking the NI ELVIS Traditional desktop 

icon or navigate to Start»All Program Files»National Instruments»

NI ELVIS Traditional»NI ELVIS Traditional. After initializing, the 

suite of LabVIEW SFP instruments opens.

To launch an instrument, click the button corresponding to the desired 

instrument. If the NI ELVIS Traditional software is properly configured 

and the benchtop workstation is cabled to the appropriate DAQ device, 

all buttons should be enabled.

If there is a problem with your configuration, such as when the NI ELVIS 

Benchtop Workstation is powered off or disconnected from the configured 

DAQ device, all instrument buttons are dimmed, and the only available 

option is to click the Configure button. Refer to the Where to Start with 

NI ELVIS document for more information about configuring NI ELVIS.

Some instruments perform similar operations using the same resources 

of the NI ELVIS hardware and the DAQ device, and therefore cannot 

run at the same time. If you launch two instruments with overlapping 

functionality that cannot run at the same time, the NI ELVIS Traditional 

software generates an error dialog describing the conflict. The instrument 

with the error is disabled and will not function until the conflict is resolved. 

Refer to Appendix D, Resource Conflicts, for more information about 

possible resource conflicts.

Arbitrary Waveform Generator (ARB)
This advanced-level SFP instrument uses the AO capabilities of the DAQ 

device. You can create a variety of signal types using the Waveform Editor 

software, which is included with the NI ELVIS Traditional software. 

You can load waveforms created with the NI Waveform Editor into the 

ARB SFP to generate stored waveforms. Refer to the NI ELVIS Traditional 

Help for more information about the Waveform Editor.

Because a typical DAQ device has two AO channels, two waveforms may 

be simultaneously generated. You can choose continuous output or a single 

output. The maximum output rate of the NI ELVIS Traditional - ARB SFP 

is determined by the maximum update rate of the DAQ device connected to 

the NI ELVIS hardware. Refer to the DAQ device documentation for these 

specifications.
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Bode Analyzer
By combining the frequency sweep feature of the function generator and 

the AI capability of the DAQ device, a full-function Bode Analyzer is 

available with NI ELVIS Traditional. You can set the frequency range of 

the instrument and choose between linear and logarithmic display scales. 

Refer to the NI ELVIS Traditional Help for required hardware connections.

Digital Bus Reader
This instrument reads digital data from the NI ELVIS digital input (DI) 

bus. You can either continuously read from the bus or you can take a single 

reading.

Digital Bus Writer
This instrument updates the NI ELVIS digital output (DO) bus with 

user-specified digital patterns. You can manually create a pattern or select 

predefined patterns, such as ramp, toggle, or walking 1s. This instrument 

can either continually output a pattern or just perform a single write. 

The output of the NI ELVIS Traditional - Digital Bus Writer SFP stays 

latched until the instrument is stopped or another pattern is output. Output 

voltage levels of the NI ELVIS DO bus are TTL compatible.

Digital Multimeter (DMM)
This commonly used instrument can perform the following types of 

measurements:

• DC voltage

• AC voltage

• Current (DC and AC)

• Resistance

• Capacitance

• Inductance

• Diode test

• Audible continuity

You can connect to the DMM from the NI ELVIS Prototyping Board or 

from the banana-style connectors on the front panel of the benchtop 

workstation.
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Dynamic Signal Analyzer (DSA)
This instrument is especially useful in advanced electrical engineering and 

physics classes. This instrument uses the analog input of the DAQ device 

to make measurements, and can either continuously make measurements or 

make a single scan. You can also apply various window and filtering 

options to the signal.

Function Generator (FGEN)
This instrument provides you with choices for the type of output waveform 

(sine, square, or triangle), amplitude selection, and frequency settings. 

In addition, the instrument offers DC offset setting, frequency sweep 

capabilities, and amplitude and frequency modulation.

Impedance Analyzer
This instrument is a basic impedance analyzer that is capable of measuring 

the resistance and reactance for passive two-wire elements at a given 

frequency.

Oscilloscope (Scope)
This instrument provides the functionality of the standard desktop 

oscilloscope found in typical undergraduate laboratories. The NI ELVIS 

Traditional - Scope SFP has two channels and provides scaling and 

position adjustment knobs along with a modifiable timebase. You can also 

choose trigger source and mode settings. The autoscale feature allows you 

to adjust the voltage display scale based on the peak-to-peak voltage of the 

AC signal for the best display of the signal. Depending on the DAQ device 

cabled to the NI ELVIS hardware, you can choose between digital or 

analog hardware triggering. You can connect to the NI ELVIS 

Traditional - Scope SFP from the NI ELVIS Prototyping Board or from the 

BNC connectors on the front panel of the benchtop workstation.

The FGEN or DMM signals can be internally routed to this instrument. 

In addition, this computer-based scope display has the ability to use cursors 

for accurate screen measurements. The sampling rate of the Oscilloscope is 

determined by the maximum sampling speed of the DAQ device installed 

in the computer attached to the NI ELVIS hardware.

Refer to the DAQ device documentation for information about the type 

of triggering supported on the device and for the maximum sampling speed 

specifications of the device.
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Two-Wire and Three-Wire Current-Voltage Analyzers
These instruments allow you to conduct diode and transistor parametric 

testing and view current-voltage curves. The two-wire instrument offers 

full flexibility in setting parameters such as voltage and current ranges, and 

can save data to a file. In addition, the three-wire instrument offers base 

current settings for measurements of NPN transistors. Refer to NI ELVIS 

Traditional Help for connection details. Both instruments have cursors for 

more accurate onscreen measurements.

Variable Power Supplies
You can control the output of the positive or negative variable power 

supply with these SFP instruments. The negative power supply can output 

between –12 and 0 V, and the positive power supply can output between 

0 and +12 V.

Using NI ELVIS Traditional with LabVIEW
This section provides an overview of using NI ELVIS with LabVIEW.

LabVIEW Express VIs
When using NI ELVIS Traditional 3.0 or later, many of the NI ELVIS 

Traditional instruments have an associated LabVIEW Express VI. The 

Express VIs are the recommended method for programming NI ELVIS in 

LabVIEW. Express VIs allow you to interactively configure the settings for 

each instrument. This enables you to develop LabVIEW applications 

without extensive programming expertise. To access the NI ELVIS 

Traditional Express VIs, open a LabVIEW block diagram and select 

Instrument I/O»Instrument Drivers»NI ELVIS Traditional from the 

function palette.
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Table 2-1 shows the available NI ELVIS Traditional Express VIs. Refer to 

the NI ELVIS Traditional Help for more information.

Low Level NI ELVIS Traditional API
Before the NI ELVIS Traditional Express VIs were created, the API 

consisted of the NI ELVIS Traditional instrument driver VIs, now referred 

to as the Low Level NI ELVIS Traditional API, which enabled you to 

programming the following components:

• Digital I/O (DIO)

• Digital Multimeter (DMM)

• Function Generator (FGEN)

• Variable Power Supplies (VPS)

• Communication Bypass

Table 2-1.  NI ELVIS Traditional Express VIs

NI ELVIS Traditional Express VI

—
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The NI ELVIS Traditional Express VIs expose all of the functionality for 

each instrument and are the recommended method for programming 

NI ELVIS in LabVIEW. The Low Level NI ELVIS Traditional VIs are 

included to provide backwards compatibility for NI ELVIS Traditional 

applications written previous to NI ELVIS Traditional 3.0. Refer to the 

NI ELVIS Traditional Help for more information about using the Low 

Level API to program NI ELVIS.

Using NI-DAQmx with NI ELVIS Traditional
Some general AI, AO, and timing functionality of the DAQ device is 

available through the NI ELVIS workstation and you can program it using 

NI-DAQmx. Refer to NI ELVIS Traditional Help and NI-DAQmx Help for 

more information.

Using NI ELVIS Traditional in SignalExpress
To use an NI ELVIS Traditional instrument within SignalExpress complete 

the following steps:

1. Launch SignalExpress.

1. Click the Add Step button.

2. If NI ELVIS Traditional 3.0 or later is installed, NI ELVIS Traditional 

is in the list of steps. Expand NI ELVIS Traditional.

3. Choose the instrument to add under Analog or Digital»Acquire or 

Generate Signals.

4. Click the Configure button to select the DAQ device cabled to the 

NI ELVIS Benchtop Workstation.

5. Set the various controls on the configuration panel appropriately for 

the measurement.

6. Run the SignalExpress project.

For more information about using NI ELVIS with SignalExpress, refer to 

the NI SignalExpress Workbench Help, which you can find through the 

Help menu in SignalExpress.

For more information about SignalExpress, refer to the Getting Started 

with SignalExpress Guide.

NI ELVIS Traditional Calibration Utility
The NI ELVIS Traditional 2.0 or later software includes a calibration 

utility that you can use to recalibrate the NI ELVIS variable power supplies 

and function generator circuitry.
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NI ELVIS in Academic Disciplines

You can use NI ELVIS in engineering, physical sciences, and biological 

sciences laboratories. NI ELVIS is suitable not only in terms of the 

included software, but also because of the custom signal conditioning 

hardware you can create with NI ELVIS. Instructors can implement the 

NI ELVIS curriculum with beginning to advanced classes to provide 

hands-on experience to students.

NI ELVIS in Engineering
NI ELVIS is suited for teaching basic electronics and circuit design to 

students in electrical engineering, mechanical engineering, and biomedical 

engineering. The suite offers full testing, measurement, and data-saving 

capabilities needed for such training. Students can use the removable 

prototyping board at home to build circuits, thus using laboratory time 

more effectively.

NI ELVIS Traditional SFP instruments, such as the Bode Analyzer, offer 

instructors an opportunity to teach advanced courses in signal analysis and 

processing. Students can construct software filters in LabVIEW and 

hardware filters on the prototyping board and compare the performance of 

those two types of filters.

Mechanical engineering students can learn sensor and transducer 

measurements in addition to basic circuit design by building custom signal 

conditioning. Students can install custom sensor adapters on the 

prototyping board. For example, installing a thermocouple jack on the 

prototyping board allows robust thermocouple connections. The 

programmable power supply can provide excitation for strain gauges used 

in strain measurements.

NI ELVIS in Biological Sciences

Caution The NI ELVIS hardware is not environmentally sealed; therefore, exercise 

caution for use in chemical and biological sciences.

Biomedical engineering departments have challenges that are similar to 

those of mechanical departments. Students typically learn basic electronics 

and build instruments such as an electrocardiogram (ECG) monitor. 

The prototyping board offers signal conditioning capability for ECG 

sensors, and the NI ELVIS Traditional SFP instruments are ideal for testing 

the circuits as students build the signal conditioning circuits.
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NI ELVIS in Physical Sciences
Physics students typically learn electronics and circuit design theory. 

NI ELVIS provides these students with the opportunity to implement these 

concepts. Physics students sometimes need signal conditioning for 

common sensors such as photoelectric multipliers or light detector sensors. 

Students can build high-gain, low-noise circuits on the removable printed 

circuit board (PCB) and study them in modern physics labs.
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3
Hardware Overview

This chapter describes the hardware components of NI ELVIS, including 

the DAQ device, the benchtop workstation, and the prototyping board. 

Appendix C, Theory of Operation, provides more information about the 

circuitry used for the different NI ELVIS measurements.

DAQ Hardware

The NI ELVIS workstation is designed to work with National Instruments 

M Series DAQ devices, which are high-performance, multifunction 

analog, digital, and timing I/O devices for PCI bus computers. Supported 

functions on DAQ devices include AI, AO, DIO, and timing I/O (TIO).

Recommended DAQ Devices
NI ELVIS Traditional software version 3.0 and later is recommended for 

use with the following DAQ devices:

• NI PCI-6251 M Series DAQ device

• NI USB-6251 Mass Termination M Series DAQ device

Note For a complete list of other supported DAQ devices, refer to Appendix E, Supported 

DAQ Devices.

Use one of the following cables to connect the NI ELVIS workstation:

• PCI M Series DAQ device:

– SHC68-68-EPM

– SHC68-68

– RC68-68

• NI USB 6251 mass termination device:

– SH68-68-EP
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NI ELVIS Benchtop Workstation

Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document 

before removing equipment covers, or connecting or disconnecting any signal wires.

This section describes the NI ELVIS Benchtop Workstation.

Refer to Figure 3-1 for the parts locator diagram for the control panel.

Figure 3-1.  Control Panel Diagram of the Benchtop Workstation

The benchtop workstation has the following controls and indicators:

• System Power LED—Indicates whether the NI ELVIS is powered on.

• Prototyping Board Power Switch—Controls the power to the 

prototyping board.

• Communications Switch—Requests disabling software control of the 

NI ELVIS. In most applications set this switch to Normal to enable the 

computer to control NI ELVIS. For more information about the 

Communications switch, refer to Appendix F, Using Bypass 

Communication Mode.
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• Variable Power Supplies Controls

– Supply– Controls

• Manual Switch—Controls whether the negative supply is in 

Manual mode or Software mode. In Manual mode, the 

voltage knob controls the negative power supply. In Software 

mode, the Variable Power Supply SFP controls the negative 

power supply.

• Voltage Adjust Knob—Controls the output of the negative 

supply. The negative supply can output between –12 and 0 V. 

You must set the Manual switch to Manual mode to use this 

knob.

– Supply+ Controls

• Manual Switch—Controls whether the positive supply is in 

Manual mode or Software mode. In Manual mode, the 

voltage knob controls the positive power supply. In Software 

mode, the Variable Power Supply SFP controls the positive 

power supply.

• Voltage Adjust Knob—Controls the output of the positive 

supply. The positive supply can output between 0 and +12 V. 

You must set the Manual switch to Manual mode to use this 

knob.

For more information about the software controls for the NI ELVIS 

Traditional - Variable Power Supplies SFP, refer to the NI ELVIS 

Traditional Help.

• Function Generator Controls

– Manual Switch—Controls whether the function generator is in 

Manual mode or Software mode.

• In Manual mode, the Function Selector, Amplitude Knob, 

Coarse Frequency Knob, and Fine Frequency Knob controls 

the function generator.

• In Software mode, the FGEN SFP controls the Function 

Generator.

– Function Selector—Selects what type of waveform is generated. 

NI ELVIS can generate sine, square, or triangle waves.

– Amplitude Knob—Adjusts the peak amplitude of the generated 

waveform.
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– Coarse Frequency Knob—Sets the range of frequencies the 

function generator can generate.

– Fine Frequency Knob—Adjusts the output frequency of the 

function generator.

For more information about the software controls for the function 

generator, refer to the NI ELVIS Traditional Help.

• DMM Connectors

– CURRENT Banana Jacks

• HI—The positive input to all the DMM functionality, except 

measuring voltage.

• LO—The negative input to all the DMM functionality, except 

measuring voltage.

– VOLTAGE Banana Jacks

• HI—The positive input for voltage measurements.

• LO—The negative input for voltage measurements.

If you use the front panel DMM inputs, do not use the DMM inputs on the 

prototyping board.

Caution By connecting different signals to both the DMM terminals on the prototyping 

board and the DMM connectors on the control panel, you are shorting them together, 

potentially damaging the circuit on the prototyping board.

Note The NI ELVIS DMM is ground referenced.

• Oscilloscope (Scope) Connectors

– CH A BNC Connector—The input for channel A of the 

Oscilloscope.

– CH B BNC Connector—The input for channel B of the 

Oscilloscope.

– Trigger BNC Connector—The input to the trigger of the 

Oscilloscope.

If you use the front panel scope inputs, do not use the scope inputs on the 

prototyping board.

Caution By connecting different signals to the Scope terminals on the prototyping board 

and the Scope connectors on the control panel, you are shorting them together, potentially 

damaging the circuit on the prototyping board.
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NI ELVIS Rear Panel
The NI ELVIS rear panel has the following components shown in 

Figure 3-2:

• The workstation power switch. Use this switch to completely power 

off the workstation.

• An AC–DC power supply connection. Use this connector to power the 

workstation.

• A 68-pin DAQ device connection. Use this connector to attach the 

DAQ device to the workstation.

Figure 3-2.  Back View of NI ELVIS Benchtop Workstation

1 Benchtop Workstation Power Switch
2 AC-DC Power Supply Connector

3 68-Pin DAQ Device Connector

1
2

3
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NI ELVIS Protection Board
NI ELVIS protects the DAQ device installed in the desktop computer by 

means of a protection board located inside the NI ELVIS Benchtop 

Workstation. This removable protection board provides short-circuit 

protection from unsafe external signals. Removing the protection board 

enables you to quickly replace a nonfunctioning board with a replacement 

unit. You can obtain the components on the protection board from 

electronics vendors and therefore service the protection board without 

sending it to NI for repairs.

Refer to Appendix B, Protection Board Fuses, for more information about 

replacing the fuses on the NI ELVIS Protection Board.

NI ELVIS Prototyping Board

This section describes the NI ELVIS Prototyping Board and how you 

can use it to connect circuits to NI ELVIS. This section also describes the 

signals that you can connect to NI ELVIS from the prototyping board and 

the connectors you can use to do so.

Caution Ensure the power to the prototyping board power switch is off before inserting the 

prototyping board into the NI ELVIS Benchtop Workstation.

You can use the prototyping board connector to install custom prototype 

boards you develop. This connector is mechanically the same as a standard 

PCI connector.

The prototyping board exposes all the signal terminals of the NI ELVIS for 

use through the distribution strips on either side of the breadboard area. 

Each signal has a row, and the rows are grouped by function.

Refer to Figure 3-3 for the parts locator diagram for the prototyping board.

Note NI recommends using 22 AWG, single connector wire for circuits built on the 

prototyping board.
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Figure 3-3.  Prototyping Board Parts Locator Diagram

Prototyping Board Power
The prototyping board provides access to a ±15 V and a +5 V power 

supply. You can use these voltage rails to construct many common circuits. 

Refer to Appendix A, Specifications, for more information about these 

voltage rails. If any of the power LEDs are not lit when the prototyping 

board power is enabled, refer to Appendix B, Protection Board Fuses, 

for details about replacing NI ELVIS fuses.
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Prototyping Board Signal Descriptions
Tables 3-1 and 3-2 describe the signals on the NI ELVIS prototyping 

board. The signals are grouped by the functionality section where they are 

located on the prototyping board.

Table 3-1.  Signal Descriptions

Signal Name Type Description

ACH <0..2> ± General AI Analog Input Channels 0 through 2 ±—Positive and negative input 

channels to differential AI channel.

ACH <3..4> ± General AI Analog Input Channels 3 and 4 ±—Positive and negative input 

channels to differential AI channel. If you are using the 

oscilloscope, you cannot use ACH <3..4> ±.

ACH 5 ± General AI Analog Input Channel 5±—Positive and negative input channel to 

differential AI channel. If you are using the DMM, you cannot use 

ACH 5±.

AI SENSE General AI Analog Input Sense—Reference for the analog channels in 

nonreferenced single-ended (NRSE) mode. For more information 

about AI modes, refer to the DAQ device documentation.

AI GND General AI Analog Input Ground—AI ground reference for the DAQ device. 

This ground signal is not connected to the NI ELVIS GROUND 

signals.

CH <A..B>+ Oscilloscope Oscilloscope Channels A and B (+)—Positive input for the 

Oscilloscope channels.

CH <A..B>– Oscilloscope Oscilloscope Channels A and B (–)—Negative input for the 

Oscilloscope channels.

TRIGGER Oscilloscope Oscilloscope Trigger—Trigger input for the Oscilloscope, 

referenced to AI GND.

3-WIRE DMM Three Wire—Voltage source for the DMM for three-wire transistor 

measurements.

CURRENT HI DMM Positive Current—Positive input for the DMM for all 

measurements besides voltage. The NI ELVIS is ground 

referenced.

CURRENT LO DMM Negative Current—Negative input for the DMM for all 

measurements besides voltage. The NI ELVIS is ground 

referenced.

VOLTAGE HI DMM Positive Voltage—Positive input for the DMM voltmeter.

VOLTAGE LO DMM Negative Voltage—Negative input for the DMM voltmeter.

DAC<0..1> Analog Outputs Analog Output Channels 0 and 1—For more information about the 

DAQ device analog output signals, refer to the M Series User 

Manual and Appendix C, Theory of Operation.



Chapter 3 Hardware Overview

© National Instruments Corporation 3-9 NI ELVIS Hardware User Manual

FUNC_OUT Function Generator Function Output—Output of the function generator.

SYNC_OUT Function Generator Synchronization Output—TTL signal of the same frequency as the 

signal on the FUNC_OUT pin.

AM_IN Function Generator Amplitude Modulation Input—Input to the amplitude modulator 

for the function generator.

FM_IN Function Generator Frequency Modulation Input—Input to the frequency modulator 

for the function generator.

BANANA <A..D> User Configurable I/O Banana Jacks A through D—Connects to the banana jacks pins.

BNC <1..2>+ User Configurable I/O BNC Connectors 1 and 2 (+)—Connects to the BNC pins.

BNC <1..2>– User Configurable I/O BNC Connectors 1 and 2 (–)—Connects to the BNC pins.

SUPPLY+ Variable Power Supplies Positive—Output of 0 to 12 V variable power supply.

GROUND Variable Power Supplies Ground—Prototyping board ground. These ground pins are 

connected together.

SUPPLY– Variable Power Supplies Negative—Output of –12 to 0 V variable power supply.

+15 V DC Power Supplies +15 V Source—Output of fixed +15 V power supply, referenced to 

the GROUND signal.

–15 V DC Power Supplies –15 V Source—Output of fixed –15 V power supply, referenced to 

the GROUND signal.

GROUND DC Power Supplies Ground—Prototyping board ground. These ground pins are 

connected together.

+5V DC Power Supplies +5V Source—Output of fixed +5 V power supply, referenced to 

the GROUND signal.

DO <0..7> DIO Digital Output Lines 0 through 7—Output of the write bus. These 

channels are used by the NI ELVIS Digital Bus Writer SFP to 

generate digital data.

WR ENABLE DIO Write Enable—Active low signal that updates when DO <0..7> are 

updated.

LATCH DIO Latch—Active low signal that pulses when data is ready on 

DO <0..7>.

GLB RESET DIO Global Reset—Active low signal that is used to reset all of the 

NI ELVIS hardware settings.

RD ENABLE DIO Read Enable—Active low signal that indicates data is being read 

from DI <0..7>.

Table 3-1.  Signal Descriptions (Continued)

Signal Name Type Description
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The NI ELVIS prototype board includes signals that route directly to the 

M Series DAQ device. Table 3-2 describes these signals.

DI <0..7> DIO Digital Input Lines 0 through 7—Input to read bus. These channels 

are used by the NI ELVIS Traditional Digital Bus Reader SFP to 

acquire digital data.

ADDRESS <0..3> DIO Address Lines 0 through 3—Output of address bus.

LED <0..7> User-Configurable I/O LEDs 0 through 7—Input to the LEDs.

DSUB SHIELD User-Configurable I/O D-SUB Shield—Connection to D-SUB shield.

DSUB PIN <1..9> User-Configurable I/O D-SUB Pins 1 through 9—Connection to D-SUB pins.

+5 V DC Power Supply +5V Source—Output of fixed +5 V power supply, referenced to 

the GROUND signal.

GROUND DC Power Supply Ground—Prototyping board ground. These ground pins are 

connected together.

Table 3-2.  M Series DAQ Device Routing

Signal Name on 

Prototype Board Direction1

M Series 

Signal Name Description2

PFI 1 Input PFI 1/P1.1 PFI Input or Static Digital Input

PFI 2 Input PFI 2/P1.2 PFI Input or Static Digital Input

PFI 5 Input PFI 5/P1.5 PFI Input or Static Digital Input

PFI 6 Input PFI 6/P1.6 PFI Input or Static Digital Input

PFI 7 Input PFI 7/P1.7 PFI Input or Static Digital Input

SCANCLK Output PFI 11/P2.3 PFI Output or Static Digital Output

RESERVED Output PFI 10/P2.2 PFI Output or Static Digital Output

CTR0_SOURCE Input PFI 8/P2.0 PFI Input or Static Digital Input

(Defaults to CTR 0 SRC in NI-DAQmx)

CTR0_GATE Input PFI 9/P2.1 PFI Input or Static Digital Input

(Defaults to CTR 0 GATE in NI-DAQmx)

CTR0_OUTPUT Output PFI 12/P2.4 PFI Output or Static Digital Output

(Defaults to CTR 0 OUT in NI-DAQmx)

Table 3-1.  Signal Descriptions (Continued)

Signal Name Type Description
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Note Refer to Appendix E, Supported DAQ Devices, for E Series DAQ device signal 

descriptions.

PFI Signal Descriptions
PFI Input or Static Digital Input—As a PFI input, you can use these signals 

to supply an external source for AI, AO, DI, and DO timing signals or 

counter/timer inputs. You can also use these signals as static digital inputs 

(port 1 or port 2).

PFI Output or Static Digital Output—As a PFI output, you can route many 

different internal AI, AO, DI, or DO timing signals to each PFI output. You 

also can route the counter/timer outputs to each PFI output. You can also 

use these signals as static digital outputs (port 1 or port 2).

Connecting Signals

This section provides information about connecting signals between the 

NI ELVIS and the DAQ device. Refer to Appendix D, Resource Conflicts, 

for a table showing possible resource conflicts when connecting NI  ELVIS 

signals.

Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document 

before removing equipment covers, or connecting or disconnecting any signal wires.

CTR1_SOURCE Input PFI 3/P1.3 PFI Input or Static Digital Input

(Defaults to CTR 1 SRC in NI-DAQmx)

CTR1_GATE Input PFI 4/P1.4 PFI Input or Static Digital Input

(Defaults to CTR 1 GATE in NI-DAQmx)

CTR1_OUTPUT Output PFI 13/P2.5 PFI Output or Static Digital Output

(Defaults to CTR 1 OUT in NI-DAQmx)

FREQ_OUT Output PFI 14/P2.6 PFI Output or Static Digital Output

1 On M Series DAQ devices, you can configure all of these signals as inputs or output; however, when used with the 

NI ELVIS workstation, these signals are fixed direction—either input or output.

2 Refer to the PFI Signal Descriptions section and the M Series User Manual for more complete descriptions of these signals.

Table 3-2.  M Series DAQ Device Routing (Continued)

Signal Name on 

Prototype Board Direction1

M Series 

Signal Name Description2
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Grounding Considerations
Because the analog channels are differential, you must establish a ground 

point somewhere in the signal path. As long as the signal you are measuring 

is referenced to one of the NI ELVIS GROUND pins, the measurement 

is correctly referenced. If a floating source, such as a battery, is being 

measured, be sure to connect one end of the signal to the NI ELVIS 

GROUND. Terminals for the NI ELVIS GROUND signal are located at 

several locations on the prototyping board. All these signals are connected 

together.

Connecting Analog Input Signals
This section describes how to connect AI signals on the NI ELVIS 

Prototyping Board. Refer to the DAQ device documentation for more 

information about types of signal sources, input modes, grounding 

configurations, and floating signal sources.

Generic Analog Input
The NI ELVIS Prototyping Board has six differential AI channels 

available—ACH<0..5>. These inputs are directly connected to the 

DAQ device input channels. The NI ELVIS prototyping board also 

exposes two ground reference pins, AI SENSE and AI GND, which are 

connected to the M Series DAQ device. Table 3-3 shows how the 

NI ELVIS input channels map to the DAQ device input channels.

Table 3-3.  Analog Input Signal Mapping

NI ELVIS Input Channel DAQ Device Input Channel

ACH0+ AI 0

ACH0– AI 8

ACH1+ AI 1

ACH1– AI 9

ACH2+ AI 2

ACH2– AI 10

ACH3+ AI 3

ACH3– AI 11

ACH4+ AI 4
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The following sections describe some special considerations for connecting 

the AI signals on the prototyping board, including sections that specifically 

pertain to the Oscilloscope and DMM.

Resource Conflicts
Some of the AI channels are used by the internal circuitry for other 

instruments, but the majority of the time you can still use the channel. You 

can use ACH<0..2> without interruption. ACH5 is interrupted if any of the 

impedance-analyzing capabilities of the DMM, such as the capacitance 

meter, diode tester, and so on, are used. If you are using the Oscilloscope, 

disconnect any signals from ACH3 and ACH4 to avoid double-driving the 

channels. For more information about possible resource conflicts, refer to 

Appendix D, Resource Conflicts. Refer to Table 3-4 for AI channel 

resource conflicts.

ACH4– AI 12

ACH5+ AI 5

ACH5– AI 13

AISENSE AI SENSE

AIGND AI GND

Table 3-4.  AI Channel Resource Conflicts

AI Channel Conflict

0 None

1 None

2 None

3 Oscilloscope CH A

4 Oscilloscope CH B

5 DMM (Capacitor, Diode Tester)

Table 3-3.  Analog Input Signal Mapping (Continued)

NI ELVIS Input Channel DAQ Device Input Channel
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DMM
Both the CURRENT and VOLTAGE inputs are available on the 

prototyping board along with an additional terminal for three-wire 

transistor measurements. The differential voltmeter inputs are labeled 

VOLTAGE HI and VOLTAGE LO. The rest of the functionality of the 

DMM is available through the CURRENT HI and CURRENT LO pins. 

The 3-WIRE pin is used for three-terminal device measurements in 

conjunction with the CURRENT HI and CURRENT LO pins. If you are 

using the DMM, you cannot use ACH 5.

Caution By connecting different signals to both the DMM terminals on the prototyping 

board and the DMM connectors on the control panel, you are shorting them together, 

potentially damaging the circuit on the prototyping board.

Oscilloscope
The inputs of the Oscilloscope are available on the prototyping board as 

CH <A..B>+, CH <A..B>–, and TRIGGER. CH <A..B> are directly 

connected to ACH3 and ACH4, respectively, on the DAQ device. If you are 

using the scope, you cannot use ACH 3 and 4.

Caution By connecting different signals to the Scope terminals on the prototyping board 

and the Scope connectors on the control panel, you are shorting them together, potentially 

damaging the circuit on the prototyping board.

Connecting Analog Output Signals
This section describes how to connect the AO signals on the prototyping 

board.

Generic Analog Output
NI  ELVIS provides access to the two analog outputs from the DAQ device 

at the DAC0 and DAC1 terminals. These channels are used by the 

NI ELVIS hardware for arbitrary waveform generation. The output of the 

DAQ device is buffered and protected by the NI ELVIS hardware.

Caution Other functions of NI ELVIS, such as the DMM and FGEN, internally use DAC0 

and DAC1, and these functions can potentially interfere with the measurements. The driver 

software generates an error message when there is a potential resource conflict.
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DC Power Supplies
The DC power supplies output a static ±15 V and +5 V. For more 

information about the DC power supplies output, refer to Appendix A, 

Specifications.

Function Generator (FGEN)
Access to the function generator on the prototyping board includes several 

additional terminals besides the function generator output signal, 

FUNC_OUT. The SYNC_OUT signal outputs a TTL-compatible clock 

signal of the same frequency as the output waveform. The AM_IN and 

FM_IN signals control the amplitude modulation (AM) and the frequency 

modulation (FM), respectively. Leave FM_IN and AM_IN disconnected if 

you do not want to apply modulation to the FGEN signal. These signals are 

in addition to the fine frequency and amplitude controls on the benchtop 

workstation. Software AM is controlled by DAC0 and software FM is 

controlled by DAC1.

Variable Power Supplies
The variable power supplies provide adjustable output voltages from 

0 to +12 V on the SUPPLY+ terminal and –12 to 0 V on the SUPPLY– 

terminal. The GROUND pin provides a connection to the same ground 

of the DC power supplies.

Bode Analyzer
The NI ELVIS Bode Analyzer uses the Function Generator to output a 

stimulus and then uses analog input channels ACH 0 and ACH 1 to 

measure the stimulus and response. On the prototyping board, connect 

FUNC_OUT to the input of the circuit and ACH 1. Connect the output to 

ACH 0.

Two-Wire Current-Voltage Analyzer
Connect the signal to Current Hi and Current Low when using the 

Two-Wire Current-Voltage Analyzer.
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Three-Wire Current-Voltage Analyzer
The Three-Wire Current-Voltage Analyzer uses Current Hi, Current Low, 

and 3-wire to plot the current-voltage response of a NPN BJT.

Impedance Analyzer
Connect the signal to Current Hi and Current Low when using the 

NI ELVIS Impedance Analyzer.

Connecting Digital I/O Signals
The digital I/O signals are TTL compatible. Refer to Appendix A, 

Specifications, for information about the behavior of the DI and DO 

signals.

If you are using Bypass Mode, refer to Appendix F, Using Bypass 

Communication Mode, for information about using digital I/O signals.

Connecting Counter/Timer Signals
The prototyping board provides access to the DAQ device counter/timer 

inputs, which are also accessible from software. These inputs are used for 

counting TTL signals and for edge detection. The CTR0_SOURCE, 

CTR0_GATE, CTR0_OUT, CTR1_GATE, and CTR1_OUT signals are 

connected to the default Counter 0 and Counter 1 PFI lines on the DAQ 

device, refer to Table 3-2. Refer to the DAQ device documentation for 

details on using and configuring counter/timers.

Connecting User-Configurable Signals
The prototyping board provides several different user-configurable 

connectors: four banana jacks, two BNC connectors, and a D-SUB 

connector. Each pin of the connector has a connection to the distribution 

strips of the prototyping board. 

Table 3-5.  NPN Transistor to Prototyping Board Connections

NPN Transistor Node Prototyping Board Connections

Collector 3-Wire

Base Current Hi

Emitter Current Low
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Eight LEDs are provided for general digital output. The anode of each LED 

is connected to the distribution strip through a 220 Ω resistor, and each 

cathode is connected to ground.

Refer to Table 3-1 for more information about the signal names for the 

user-configurable I/O connectors.
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4
Calibration

Electronic components such as ADCs are characterized by nonlinearities 

and drift due to time and temperature. Compensating for these inherent 

sources of error requires device self-calibration. To improve the accuracy 

of the system, you should periodically calibrate both the NI ELVIS 

workstation and the M Series DAQ device.

Running the NI ELVIS Traditional Calibration Utility

Complete the following steps to self-calibrate the M Series DAQ device:

1. Launch MAX.

2. Expand Devices and Interfaces.

3. Find the M Series DAQ device in the list of devices and interfaces.

4. Right-click the appropriate M Series DAQ device.

5. Select Self-Calibrate.

To calibrate the NI ELVIS workstation, run the calibration utility included 

in the NI ELVIS Traditional software from Start»National Instruments»

NI ELVIS Traditional»Calibration Wizard.

You can use the NI ELVIS Traditional Calibration Wizard to calibrate the 

Variable Power Supply and Function Generator.

Note This calibration is only applied when using these instruments in software mode.
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A
Specifications

This appendix lists the specifications of the NI ELVIS. These specifications 

are typical after a 30 minute warm-up time, at 23 °C, unless otherwise 

noted.

Note NI ELVIS includes a calibration utility so that you can recalibrate the circuitry for 

the variable power supplies and function generator.

Analog Input
Refer to the Analog Input section of the DAQ device specifications 

documentation.

Arbitrary Waveform Generator1/Analog Output
Number of output channels .................... 2

Maximum frequency .............................. DC to DAQ device

AO update rate/10

Full-power bandwidth ............................ 27 kHz

Output amplitude.................................... ±10 V

Resolution .............................................. 12 bits or 16 bits,

DAQ device dependent

Output drive current ............................... 25 mA

Output impedance .................................. 1 Ω

Slew rate................................................. 1.5 V/μs

1   The Arbitrary Waveform Generator does not work with the NI 6014, NI 6024E, or NI 6036E.
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Bode Analyzer
Amplitude accuracy ................................12 or 16 bits,

DAQ device dependent

Phase accuracy........................................1 degree

Frequency range .....................................5 Hz to 35 kHz

DC Power Supplies

+15 V Supply
Output current.........................................Self-resetting circuitry, not to shut 

down at or below 500 mA

Output voltage ........................................15 V at ±5% no load

Line regulation........................................0.5% max

Load regulation.......................................1% typ, 5% max, 0 to full load1

Ripple and noise .....................................1%

–15 V Supply
Output current.........................................Self-resetting circuitry, not to shut 

down at or below 500 mA2

Output voltage ........................................–15 V at ±5% no load

Line regulation........................................0.5% max

Load regulation.......................................1% typ, 5% max, 0 to full load 1

Ripple and noise .....................................1%

1   Full load refers to the maximum current output of the power supply. Load regulation is linear over 0 to full load; therefore at 
50% of full load, the output drops by 50% of the load regulation specification.

2   Total current drawn from –15 V supply and variable power supplies cannot exceed 500 mA.
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+5 V Supply
Output current ........................................ Self-resetting circuitry, not to shut 

down at or below 2 A

Output voltage........................................ +5 V at ±5% no load

Line regulation ....................................... 0.50% max

Load regulation ...................................... 22% typ, 30% max 0 to full load1

Ripple and noise..................................... 1%

Digital I/O

Resolution
Digital input channels ............................ 8 bits

Digital output channels .......................... 8 bits

Digital addressing .................................. 4 bits

Digital Input
II ............................................................. 1.0 μA max

VIH .......................................................... 2.0 V min

VIL .......................................................... 0.8 V max

Digital Output
VOH......................................................... 3.38 V min at 6 mA

4.4 V min at 20 μA

VOL ......................................................... 0.86 V max at 6 mA

0.1 V max at 20 μA

1   Full load refers to the maximum current output of the power supply. Load regulation is linear over 0 to full load; therefore at 
50% of full load, the output drops by 50% of the load regulation specification.
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DMM

Capacitance Measurement
Accuracy .................................................1%

Range ......................................................50 pF to 500 μF in three ranges

Test frequency ........................................120 or 950 Hz,

software-selectable

Max test frequency voltage.....................1 Vp-p sine wave,

software-selectable

Continuity Measurement
Resistance threshold ...............................15 Ω max, software-selectable

Test voltage.............................................3.89 V, software-selectable

Current Measurement
Accuracy

AC....................................................0.25% ±3 mA1, 2

DC....................................................0.25% ±3 mA2

Common-mode voltage ..........................±20 V max

Common-mode rejection ........................70 dB min

Range ......................................................±250 mA in two ranges, max

Resolution ...............................................12 or 16 bits,

DAQ device dependent

Shunt resistance ......................................0.5 Ω

Voltage burden .......................................2 mV/mA

Diode Measurement3

Voltage threshold....................................1.1 V max

1   25 Hz to 10 kHz

2   Proper null correction when measuring on high common-mode voltage can reduce the ±3 mA offset error to 200 μA of noise.

3   The Two-Wire Current Voltage Analyzer SFP is the recommended instrument for diode measurement.
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Inductance Measurement
Accuracy ................................................ 1%

Range ..................................................... 100 μH to 100 mH

Test frequency........................................ 950 Hz, software-selectable

Test frequency voltage ........................... 1 Vp-p sine wave,

software-selectable

Resistance Measurement
Accuracy ................................................ 1%

Range ..................................................... 5 Ω to 3 MΩ, in four ranges

Test frequency........................................ 120 Hz, software-selectable

Test frequency voltage ........................... 1 Vp-p sine wave,

software-selectable

Voltage Measurement
AC

Accuracy ......................................... 0.3% ±0.001% full-scale1

Range .............................................. ±14 Vrms in four ranges, max

DC

Accuracy ......................................... 0.3% ±0.001% full-scale, max

Range .............................................. ±20 V in four ranges, max

Input impedance..................................... 1 MΩ

Dynamic Signal Analyzer
Input range ............................................. ±10 V in four ranges

Input resolution ...................................... 12 or 16 bits,

DAQ device dependant

1   100 Hz to 10 kHz
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Function Generator
Frequency range .....................................5 Hz to 250 kHz in five ranges

Software-controlled

frequency resolution ...............................0.8%

Frequency set point accuracy..................3% of range, max

Frequency read back accuracy................±0.01%

Output amplitude ....................................±2.5 V

Software amplitude resolution................8 bits

Offset range ............................................±5 V

AM voltage .............................................10 V, max

Amplitude modulation ............................Up to 100%

FM voltage..............................................10 V, max

Amplitude flatness

To 50 kHz ........................................0.5 dB

To 250 kHz......................................3 dB

Frequency modulation ............................±5% of full-scale, max

Output impedance...................................50 Ω guaranteed. Refer 

to Appendix C, Theory of 

Operation, for more information 

about the output impedance 

configuration options.

Impedance Analyzer
Measurement frequency range................5 Hz to 35 kHz

Oscilloscope
Refer to the Analog Input section of the DAQ device specifications 

documentation.
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Two-Wire Current-Voltage Analyzer
Current range.......................................... ±10 mA

Voltage sweep range .............................. ±10 V

Three-Wire Current-Voltage Analyzer1

Minimum base current increment .......... 15 μΑ

Maximum collector current.................... 10 mA

Maximum collector voltage ................... 10 V

Variable Power Supplies

Positive Supply
Output voltage........................................ 0 to 12 V

Ripple and noise..................................... 0.25%

Software-controlled resolution............... 7 bits

Current limiting...................................... 0.5 V at 160 mA,

5 V at 275 mA,

12 V at 450 mA

Negative Supply
Output voltage........................................ 0 to –12 V

Ripple and noise..................................... 0.25%

Software-controlled resolution............... 7 bits

Current limiting...................................... 0.5 V at 130 mA,

5 V at 290 mA,

12 V at 450 mA2

1   This SFP instrument is intended for use only with NPN BJT transistors.

2   Total current drawn from –15 V and the negative variable power supply cannot exceed 500 mA.
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Physical
Dimensions ............................................. 31.75 × 30.48 × 12.7 cm

(12.5 × 12.0 × 5 in.)

Weight ....................................................4.08 kg (9.0 lb)

Prototyping board

Suggested field-wiring diameter.............22 AWG, single connector

Maximum Working Voltage
Maximum working voltage refers to the signal voltage plus the

common-mode voltage.

Channel-to-earth .....................................±20 V, Measurement Category I

Channel-to-channel.................................±20 V, Measurement Category I

Caution Do not use for connection to signals in Categories II, III, or IV.

Environmental
Operating temperature ............................0 to 40 °C

Storage temperature ................................–20 to 70 °C 

Humidity .................................................10 to 90% relative humidity, 

noncondensing

Maximum altitude...................................2,000 m

Pollution Degree (indoor use only) ........2

Safety
This product meets the requirements of the following standards of safety 

for electrical equipment for measurement, control, and laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1, CSA 61010-1 

Note For UL and other safety certifications, refer to the product label or the Online 

Product Certification section.
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Electromagnetic Compatibility
This product meets the requirements of the following EMC standards for 

electrical equipment for measurement, control, and laboratory use:

• EN 61326 (IEC 61326): Class A emissions; Basic immunity

• EN 55011 (CISPR 11): Group 1, Class A emissions

• AS/NZS CISPR 11: Group 1, Class A emissions

• FCC 47 CFR Part 15B: Class A emissions

• ICES-001: Class A emissions

Note For the standards applied to assess the EMC of this product, refer to the Online 

Product Certification section. 

Note For EMC compliance, operate this product according to the documentation.

CE Compliance
This product meets the essential requirements of applicable European 

Directives as follows:

• 2006/95/EC; Low-Voltage Directive (safety)

• 2004/108/EC; Electromagnetic Compatibility Directive (EMC)

Online Product Certification
Refer to the product Declaration of Conformity (DoC) for additional 

regulatory compliance information. To obtain product certifications and 

the DoC for this product, visit ni.com/certification, search by model 

number or product line, and click the appropriate link in the Certification 

column.

Environmental Management
NI is committed to designing and manufacturing products in an 

environmentally responsible manner. NI recognizes that eliminating 

certain hazardous substances from our products is beneficial to the 

environment and to NI customers.

For additional environmental information, refer to the NI and the 

Environment Web page at ni.com/environment. This page contains the 

environmental regulations and directives with which NI complies, as well 

as other environmental information not included in this document.
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Waste Electrical and Electronic Equipment (WEEE)
EU Customers At the end of the life cycle, all products must be sent to a WEEE recycling 

center. For more information about WEEE recycling centers and National Instruments 

WEEE initiatives, visit ni.com/environment/weee.

RoHS

National Instruments  (RoHS)
National Instruments RoHS ni.com/environment/rohs_china

(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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B
Protection Board Fuses

This appendix describes the fuses on the NI ELVIS Protection Board 

and provides instructions on how to remove the protection board from the 

NI ELVIS Benchtop Workstation, debug the protection board, and change 

fuses.

Removing the Protection Board

The protection board detaches from the NI ELVIS Benchtop Workstation 

as shown in Figure B-1. Refer to the Where to Start with NI ELVIS 

document for more parts locator diagrams of the NI ELVIS Benchtop 

Workstation.

Figure B-1.  NI ELVIS Benchtop Workstation with Protection Board Removed

1 NI ELVIS Protection Board 2 NI ELVIS Benchtop Workstation

1

2
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Complete the following steps to remove the protection board from the 

benchtop workstation. Refer to Figure B-1 as needed.

1. Unplug the power cable. Refer to the Where to Start with the NI ELVIS 

document for an illustration of the switch location.

2. Unplug the 68-pin cable and the power supply cable from the benchtop 

workstation.

3. Disconnect the prototyping board from the benchtop workstation.

4. Unscrew the captive screws located on the back of the NI ELVIS 

Protection Board.

5. Gently pull on the captive screws to remove the protection board.

Debugging the Protection Board

The protection board provides a level of electrical protection between the 

prototyping board and the motherboard of the NI ELVIS workstation. This 

protection consists of fuses for the high-current signals—such as the AO 

channels and DMM, and 100 Ω current-limited resistors for the low-current 

signals—such as the AI channels and digital signals. If too much current 

begins to flow to or from a particular signal on the prototyping board, the 

fuse or resistor breaks down, opening the connection electrically.

The +15 V, –15 V, and +5 V lines are protected by self-resetting circuitry. 

After the cause of the circuit problem is resolved, the circuit resets.

To debug the protection board, you need a DMM with an ohmmeter. 

Complete the following steps to debug the protection board:

1. Unplug the power cable.

2. Remove the protection board assembly from the rest of the NI ELVIS 

workstation. For instructions on removing the protection board, refer 

to the Removing the Protection Board section.

3. Check the fuses, since these signals are much more likely to have been 

overloaded. To check the fuse, verify that there is continuity across the 

fuse. If all the fuses are operational, proceed to the resistor packs.

4. Verify that the resistance across each resistor is 100 Ω, ±5%. 

One resistor is located between each of the following pairs of pins: 

1 and 16, 2 and 15, 3 and 14, 4 and 13, 5 and 12, 6 and 11, 7 and 10, 

and 8 and 9. The resistor packs are socketed so that you can easily 

replace resistors.
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Caution Before restoring power to the circuit, be sure the problem that caused the 

protection board component to fail has been resolved to keep the same fuse or resistor from 

failing again.

If you replace a fuse, use a 0.5 A/250 V (T 0.5 A L 250V), 5 × 20 mm, 

slow blow Littelfuse.

Cautions For continued protection against fire, replace only with fuses of the same type 

and rating.

The fuses on NI ELVIS are glass. Use care when removing the fuses to prevent injury from 

broken glass.

Figure B-2 shows the location of the different fuses and circuit protection 

circuitry for the NI ELVIS hardware, and the location of the resistor packs.

Figure B-2.  Parts Locator Diagram for NI ELVIS Protection Board

1 Power Supply –
2 Power Supply +
3 CURRENT Fuses

4 Resistor Packs <1..8>

5 +15 V Current Limiting Circuitry
6 –15 V Current Limiting Circuitry
7 +5 V Current Limiting Circuitry
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Table B-1 shows the relationship between the resistor packs and the 

NI ELVIS components.

Reinstalling the Protection Board

Reinstall the NI ELVIS Protection Board before resuming use of 

NI ELVIS. To replace the protection board, complete the following steps:

1. Reinsert the PCI connector of the protection board into the benchtop 

workstation rear connector.

2. Tighten the four captive screws located on the back of the protection 

board.

3. Plug in the 68-pin cable and the power supply.

4. Plug in the power cable.

5. Power on NI ELVIS.

Table B-1.  Resistor Packs and NI ELVIS Components

Resistor Pack NI ELVIS Component

RP1 Analog input

RP2 Analog input

RP3 AM_IN, FUNC_OUT, SYNC_OUT, AI SENSE

RP4 Counter/timer I/O

RP5 Digital output

RP6 Digital input

RP7 SCANCLK, programmable function I/O

RP8 ADDRESS <0..3>
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C
Theory of Operation

This appendix provides additional information about the basic operation 

of the NI ELVIS circuitry for the DMM, function generator, impedance 

analyzer, two- and three-wire current-voltage analyzers, and analog output.

Note To reduce measurement error, calibrate the DAQ device before each session.

DMM Measurements

The DAQ device is configured for differential measurement mode for all 

DMM measurements. Each DMM reading is referenced to the NI ELVIS 

GROUND signal. The NI ELVIS Traditional software typically sets the 

input signal limitations, but some NI ELVIS Traditional SFP instruments 

allow you to manually change the limits.

Note NI ELVIS does not support measuring signals with large common-mode voltages. 

You must ground reference floating signals.

Voltmeter
When you use the voltmeter, differential channel seven of the DAQ 

device (AI 7 and AI 15) is used to read the voltage signal from NI ELVIS. 

NI ELVIS applies a gain of 0.5 to the voltages that are applied to 

VOLTAGE HI and VOLTAGE LO.
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Block Diagram
Figure C-1 shows a basic block diagram of the NI ELVIS voltmeter. The 

paragraphs that follow the figure describe each section of the figure in more 

detail.

Figure C-1.  NI ELVIS Voltmeter Block Diagram

Prototyping Board and Benchtop Workstation Connectors—The input 

to the NI ELVIS voltmeter circuit can come from the NI ELVIS 

Prototyping Board or from the connectors on the NI ELVIS Benchtop 

Workstation control panel. When the prototyping board is powered off, 

both connections remain active.

Protection Board—The inputs to the voltmeter are not externally 

protected on the NI ELVIS Protection Board. The two inputs are combined 

on the protection board and passed to the NI ELVIS motherboard.

NI  ELVIS Motherboard—The VOLTAGE HI and VOLTAGE LO input 

terminals are divided with 511 kΩ input resistors. A manual adjustment is 

made at the factory for common-mode rejection. The adjusted 

common-mode rejection is typically above 80 dB.

A B C D

Prototyping

Board

Protection Board NI ELVIS Motherboard DAQ Device 

Benchtop

Workstation

Control

Panel

VOLTAGE HI

VOLTAGE HI

VOLTAGE LO

VOLTAGE LO

MUX

Common-

Mode

Rejection

Adjustment

2

AI 7+

AI 15–

511 kΩ

Voltmeter Signal Path

Note: This VOLTAGE HI and VOLTAGE LO signal routes

first to the motherboard and then to the protection board

where they are shorted to the signals as shown.
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The operational amplifier used by NI ELVIS is a fully differential JFET 

input with a gain of 0.5. The input slew rate is typically 11 V/μs. This high 

slew rate helps minimize AC signal distortion.

The internal NI ELVIS bus sets the differential channel seven multiplexer 

to read the voltmeter voltage. You cannot run the voltmeter with any other 

DMM functions.

DAQ Device—The DAQ device takes the voltage reading on differential 

channel seven and converts the raw voltage into the voltage reading that is 

displayed in the NI ELVIS Traditional software.

Internal Calculations
The following values are stored in the NI ELVIS EEPROM:

• Gain—Gain error correction for NI ELVIS and the DAQ device

• Offset—Offset error correction for NI ELVIS and the DAQ device

These values are used when calculating voltage readings from the 

NI ELVIS. To calculate the voltage read on differential channel seven, 

use the following formula:

The NI ELVIS Traditional software then performs the following 

calculations:

Voltage Returned is displayed in the NI ELVIS Traditional software.

Current Meter
When you use the current meter, differential channel seven of the DAQ 

device (AI 7 and AI 15) is used to read the current from NI ELVIS. The 

current read from NI ELVIS is referenced to the NI ELVIS GROUND 

signal. The current is measured across the CURRENT HI and 

CURRENT LO terminals. The current flowing across the shunt is 

converted to voltage by a difference amplifier.

Voltage Read
VOLTAGE HI VOLTAGE LO–

2
---------------------------------------------------------------------------=

Voltage Returned DC Voltage Read Offset–( ) Gain×=

Voltage Returned AC Gain VAC
2

VDC
2

–( )×=
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Block Diagram
Figure C-2 shows a basic block diagram of the NI ELVIS current meter. 

The paragraphs that follow the figure describe each section of the figure in 

more detail.

Figure C-2.  NI ELVIS Current Meter Block Diagram

Prototyping Board and Benchtop Workstation Connectors—The input 

to the NI ELVIS current meter circuit can come from the NI ELVIS 

Prototyping Board or from the connectors on the NI ELVIS Benchtop 

Workstation control panel. When the prototyping board is powered off, the 

CURRENT HI and CURRENT LO terminals from the prototyping board 

are disconnected, and any current from the prototyping board stops 

flowing.

Protection Board—The protection board has fuses for each channel. 

These fuses handle overcurrent conditions.

A B C D

Prototyping

Board

Protection Board NI ELVIS Motherboard DAQ Device 

Benchtop

Workstation

Control

Panel

CURRENT HI

CURRENT HI

CURRENT LO

CURRENT LO

MUX

AI 7

AI 15

+

–

Fuses Switches Shunt Diff Amp

Current Meter Signal Path

Note: This CURRENT HI and CURRENT LO signal routes first

to the motherboard and then to the protection board as shown.
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NI ELVIS Motherboard—A 0.5 Ω current shunt resistor is used at the 

input of a difference amplifier to convert the current to a voltage.

The current meter is not adjusted for common-mode rejection. The 

common-mode rejection of the current meter is determined by the 

difference amplifier.

The output voltage is multiplexed to differential channel seven.

DAQ Device—The DAQ device takes the reading on differential channel 

seven and converts the voltage reading into the current that is displayed in 

the NI ELVIS Traditional software.

Internal Calculations
The following values are stored in the NI ELVIS EEPROM:

• Gain—Shunt resistor value, gain error correction for NI ELVIS and 

the DAQ device are included

• Offset—System offset error correction, includes NI ELVIS and DAQ 

device offset

The voltage returned can represent AC or DC current. The offset variable 

should remove most offset caused by NI ELVIS and/or the DAQ device.

VDC—DC measurement of the voltage on differential channel seven

VAC—AC measurement of the voltage on differential channel seven

Current AC or Current DC is displayed in the NI ELVIS Traditional 

software.

Current AC Gain VAC
2

VDC
2

–( )×=

Current DC VDC Offset–( ) Gain×=
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Function Generator

NI ELVIS includes a hardware function generator. The function generator 

can generate sine, triangle, and square waves. You can modulate the output 

amplitude and frequency manually, with software, or using a combination 

of both.

Block Diagram
Figure C-3 shows a basic block diagram of the NI ELVIS function 

generator. The paragraphs that follow the figure describe each section

of the figure in more detail.

Figure C-3.  Function Generator Block Diagram

Prototyping Board and Benchtop Workstation Connectors—The 

function generator output signal, FUNC_OUT, is only on the prototyping 

board.

Protection Board—On the protection board, the function generator passes 

through a 100 Ω current-fused resistor.

NI  ELVIS Motherboard—NI ELVIS uses a monolithic function 

generator integrated circuit (IC) to generate waveforms. This IC accepts 

frequency and amplitude modulation. You can adjust the output amplitude 
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MUX
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–

Switch
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FM

AM

Wave
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Amplitude
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FUNC OUT

Function Generator Signal Path
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of the XR 2206 with an internal 8-bit MDAC or manually with a knob on 

the NI ELVIS Benchtop Workstation control panel.

The coarse frequency is set by using one of four frequency selection 

capacitors. The fine frequency is adjusted by the adjusting the onboard 

8-bit DAC.

The adjusted output signal is multiplexed into a unity gain circuit. The 

output of the gain circuit runs through a 50 Ω resistor. NI ELVIS uses the 

function generator output signal, FUNC_OUT, after the 50 Ω resistor for 

other internal instruments.

You can disconnect the function generator from the NI ELVIS Prototyping 

Board with the prototyping board power switch.

Impedance Analyzer

The NI ELVIS Traditional - Impedance Analyzer is an SFP instrument that 

can measure specific device under test (DUT) impedance characteristics. 

NI ELVIS determines impedance using an AC sine wave source that is 

produced by the NI ELVIS function generator on the CURRENT HI pin to 

excite the DUT. The resulting sine waves are measured on CURRENT HI 

and CURRENT LO. The NI ELVIS Impedance Analyzer breaks out the 

phase, magnitude, resistance, and reactance of the DUT. 

Block Diagram
Figure C-4 shows a basic block diagram of the NI ELVIS impedance 

analyzer. The diagrams and paragraphs that follow Figure C-4 describe the 

circuitry for the CURRENT HI and CURRENT LO signals.

Figure C-4.  Impedance Analyzer Block Diagram

A B C

Prototyping BoardNI ELVIS Motherboard DAQ Device

Function

Generator
DUT

CURRENT HI

CURRENT LO

AI 5

AI 7

Impedance Analyzer Signal Path
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CURRENT HI
The hardware connection to the CURRENT HI pin is shown in Figure C-5. 

The paragraphs that follow the figure describe each section of the figure in 

more detail.

Figure C-5.  CURRENT HI Block Diagram

NI ELVIS Motherboard—The output of the NI ELVIS hardware function 

generator is routed internally to the gain of the CURRENT HI pin.

The gain circuit (labeled G in Figure C-5) provides a resistive element 

(labeled R in Figure C-5) to always insure a minimum resistance.

CURRENT HI is routed to AI 5 for measurements. Because the 

AI 5 voltage is measured after the onboard resistor, the onboard resistor 

is not included in the calculations.

The output to the NI ELVIS Prototyping Board is controlled by the 

prototyping board power switch.

Protection Board—The output of the CURRENT HI is fused for 

overcurrent protection. Simple shorts should not blow the fuse.

A B C

D

Prototyping

Board

Protection Board NI ELVIS Motherboard

DAQ Device 

Benchtop

Workstation

Control

Panel

CURRENT HI

CURRENT HI

Function

Generator

+

–

SwitchFuses

AI 5

AI 13

MUX MUX
R

G

Impedance Analyzer Signal Path

Note: This CURRENT HI signal routes first to the

motherboard and then to the protection board as shown.
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Prototyping Board and Benchtop Workstation Connectors—When the 

NI ELVIS Prototyping Board is powered off, the CURRENT HI pin from 

the prototyping board is disconnected; however, the NI ELVIS Benchtop 

Workstation control panel connection is always connected.

DAQ Device—The DAQ device reads the reference sine wave on AI 5. 

The AI 5 voltage reading is the input from the NI ELVIS to the DUT.

CURRENT LO
The hardware connection to the CURRENT LO pin is shown in Figure C-6. 

The paragraphs that follow the figure describe each section of the figure in 

more detail.

Figure C-6.  CURRENT LO Block Diagram

Prototyping Board and Benchtop Workstation Connectors—When the 

NI ELVIS Prototyping Board is powered off, the CURRENT LO pin from 

the prototyping board is disconnected. The NI ELVIS Benchtop 

Workstation control panel connection is always connected.

Protection Board—The signal from the DUT passes through a fuse on the 

protection board. This fuse adds resistance to the measurement.

A B C D
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Control
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CURRENT LO

CURRENT LO

MUX
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+
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Note: This CURRENT LO signal routes first to the

motherboard and then to the protection board as shown.
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NI ELVIS Motherboard—When the prototyping board is powered off, 

the CURRENT LO pin from the prototyping board is disconnected.

You can switch the input path between impedance and current 

measurements by modifying the LabVIEW VIs that are included in the 

NI ELVIS Traditional source code. You cannot measure impedance and 

current at the same time.

The input voltage across the DUT has a programmable gain applied. 

NI ELVIS has four programmable gain ranges that you can select with the 

NI ELVIS Traditional - Impedance Analyzer SFP. 

The input to the op-amp is protected from overvoltage and overcurrent 

conditions. This protection should prevent damage to the op-amp or the 

gain stage. The output of the op-amp is multiplexed to differential channel 

seven.

DAQ Device—The DAQ device reads the output sine wave on differential 

channel seven. The AI 7 reading is used as the signal (reference B) for the 

impedance measurements.

Internal Calculations
The following values are stored in the NI ELVIS EEPROM:

• Gain—System gain error correction, gain error correction for 

NI ELVIS and the DAQ device

• Inductance Offset—System inductance offset error correction, 

NI ELVIS and the DAQ device

• Capacitance Offset—System capacitance offset error correction, 

NI ELVIS and the DAQ device

• CA Slope—Actual calibrated value of each feedback resistor 

(four values)

The software acquires two waveforms from differential channel seven 

(the signal) and AI 5 (the reference channel) and applies the following 

formula:

Gain Amplitude
Referenced Amplitude

Signal Amplitude
-----------------------------------------------------=
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Gain Amplitude is combined with the feedback resistor used on the 

NI ELVIS to determine the impedance. CA Slope is calibrated at the factory 

to determine the actual impedance for the feedback resistor.

Z is combined with the phase to determine the resistive and reactive 

components of the DUT. The phase difference of the acquired sine waves 

is measured in reference to AI 5,

to determine the inductive or capacitive elements of the DUT, Reactance 

and Susceptance. The magnitude of the phase determines which element is 

present. The frequency is the frequency you set.

Each inductance and capacitance reading includes the offset variable stored 

in the EEPROM to help eliminate offset errors.

Resistance Meter
The resistance meter is a subset of the NI ELVIS Traditional - Impedance 

Analyzer, and it uses the same circuitry. To get more accurate readings, the 

function generator output frequency is set to 120 Hz, and the amplitude is 

locked at 1 Vp-p. These settings allow a focused calibration that reduces 

resistive and capacitive offset. The resistance meter uses four ranges to 

measure from 5 Ω to 3 MΩ .

Impedance (Z)
CA Slope

Gain Amplitude
--------------------------------------=

Reactance Z Phase
π

180
---------×⎝ ⎠

⎛ ⎞cos×=

Reactance Z sine Phase
π

180
---------×⎝ ⎠

⎛ ⎞×=

Susceptance
1–

Reactance
-------------------------=

Inductance
Reactance

2 π× Frequency×
----------------------------------------------- Inductance Offset+=

Capacitance
Susceptance

2 π× Frequency×
----------------------------------------------- Capacitance Offset+=
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Inductance Meter
The inductance meter is a subset of the NI ELVIS Traditional - Impedance 

Analyzer, and it uses the same circuitry. To get more accurate readings, the 

function generator output frequency is set to 950 Hz, and the amplitude is 

locked at 1 Vp-p. These settings allow a focused calibration that reduces 

resistive and capacitive offset.

Capacitance Meter
The capacitance meter is a subset of the NI ELVIS Traditional - Impedance 

Analyzer, and it uses the same circuitry. You can select electrolytic and 

normal capacitors. To get more accurate readings on electrolytic capacitors, 

the function generator output frequency is set to 120 Hz, and the amplitude 

is locked at 2 Vp-p with a DC offset of 2.5 V. For normal capacitors, the 

function generator output frequency is set to 950 Hz, and the amplitude is 

locked at 1 Vp-p. These settings allow a focused calibration that reduces 

resistive and capacitive offset.

Two-Wire Current-Voltage Analyzer

The two-wire measurement is made by using the DAQ device AO 0 signal 

to generate a user-controlled voltage sweep. The voltage is read before 

the DUT on AI 5 and then across the DUT on AI 7. The NI ELVIS 

Traditional - Impedance Analyzer circuitry provides the feedback resistor 

that transforms the current flowing into the CURRENT LO pin into a 

voltage. The CURRENT HI pin is the output voltage source on the 

prototyping board and benchtop workstation control panel.

Figure C-7.  Two-Wire Measurement Block Diagram

A B C

Prototyping BoardNI ELVIS Motherboard DAQ Device

DUT

CURRENT HI

CURRENT LO

AI 5

AI 7

Two-Wire Current Voltage Analyzer Signal Path

DAC0
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Internal Calculations
The following values are stored in the NI ELVIS EEPROM:

CA Slope—Actual value of each feedback resistor (four values)

The voltage output on CURRENT HI pin is from the DAQ device DAC0. 

The CURRENT HI pin is read on AI 5 and stored as the VOLTAGE (V) that 

is displayed.

The input current is measured on the CURRENT LO pin of the prototyping 

board. The CURRENT LO pin is read on AI 7. The DAQ device can only 

read voltage, so the current is converted to voltage. The NI ELVIS 

Traditional - Impedance Analyzer circuitry converts the current to voltage.

The voltage read is then converted back to current using Ohm’s Law:

For R, use the NI ELVIS feedback resistor, CA Slope, and for V, use the 

AI 7 voltage.

Measured Current is converted to milliamps and displayed.

Three-Wire Current-Voltage Analyzer

The three-wire measurement is made by using the DAQ device AO 0 and 

AO 1 to generate output voltages that you control. The voltage is read 

before going into the DUT on AI 5 and AI 6 and then across the DUT on 

AI 7. The NI ELVIS Traditional - Impedance Analyzer circuitry provides 

the feedback resistor that transforms the current flowing into the 

CURRENT LO pin into a voltage. The CURRENT HI pin is the output 

current source for the DUT on the prototyping board. This current is 

measured and converted to voltage by a 332 Ω resistor on NI ELVIS. The 

3-WIRE pin is measured on AI 6 and is the source voltage that is swept.

V I R×=

Measured Current (in Amps)
CH7 voltage

CA Slope
------------------------------=
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Figure C-8.  Three-Wire Measurement Block Diagram

Internal Calculations
The following values are stored in the NI ELVIS EEPROM:

CA SLOPE—Actual value of each feedback resistor (four values)

The voltage generated on the 3-WIRE pin is from the DAQ device AO 1. 

This voltage is read on AI 6 internal to NI ELVIS. This voltage is displayed 

as the Voltage (Vc) in the Three-Wire Current-Voltage Analyzer SFP.

The base current output on the CURRENT HI pin is from the DAQ device 

AO 0. The CURRENT HI pin is read on AI 5 as a voltage. The DAQ device 

can only read voltage, so the current is converted to voltage.

The voltage read is then converted back to current by using Ohm’s Law.

For R, use the NI ELVIS onboard 332 Ω resistor, and for V, use the 

CH5 voltage.

The Base current, Ib, is not displayed on the SFP.

The input collector current is measured on the CURRENT LO pin of the 

prototyping board. The CURRENT LO pin is read on AI 7. The DAQ 

device can only read voltage, so the current is converted to voltage. The 

NI ELVIS - Traditional Impedance Analyzer circuitry is used to convert 

the current to voltage.

A B C

Prototyping BoardNI ELVIS Motherboard DAQ Device

DAC1

DAC0

3-Wire

DUT

3-WIRE

CURRENT LO

CURRENT HI

AI 6

AI 7

AI 5

Three-Wire Current Voltage Analyzer Signal Path

Ib (Amps)
CH5 voltage

332 Ω
------------------------------=
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The voltage read is then converted back to current by using Ohm’s Law.

For R, use the NI ELVIS feedback resistor, CA Slope, and for V, use the 

CH7 voltage.

The collector current is displayed as Current Ic (A).

To determine the Beta, ß, of the DUT, use the following equation:

ß is not displayed on the SFP.

Arbitrary Waveform Generator/Analog Output

The NI ELVIS buffers the output from the DAQ device. This buffer 

prevents damage to the DAQ device. The NI ELVIS is protected against 

overvoltage and overcurrent conditions.

Figure C-9 shows a basic block diagram of the NI ELVIS AO circuitry. The 

paragraphs that follow the figure describe each section of the figure in more 

detail.

Figure C-9.  Analog Output Block Diagram
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Prototyping Board—You can only access the output channels of the 

NI ELVIS DAC <0..1> on the prototyping board. When the prototyping 

board is powered off, the output is disconnected.

NI ELVIS Motherboard—The DAQ device AO 0 and AO 1 are buffered 

on the NI ELVIS. This buffer allows the NI ELVIS power supply to drive 

DAC0 and DAC1 on the prototyping board. The DAQ device provides the 

voltage, but not the current. The output signal is not adjusted for offset 

caused by NI ELVIS.

Refer to the Arbitrary Waveform Generator/Analog Output section of 

Appendix A, Specifications, for further details.

DAQ Device—The DAQ device must have analog output capability to use 

the NI ELVIS analog output. In order to generate waveforms or patterns, 

the DAQ device must have buffered output.
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D
Resource Conflicts

Figure D-1 summarizes the resource conflicts you might encounter if you 

run certain NI ELVIS circuitry simultaneously. The variable power 

supplies and digital circuitry are not included in this figure because they do 

not create any resource conflicts.

To use the information in Figure D-1, find the instrument you want to use 

in the left column. That row lists all the functions that are resource 

conflicts. If the intersecting box contains an –, you can use those functions 

simultaneously without any conflicts.
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E
Supported DAQ Devices

The NI ELVIS workstation supports the DAQ devices listed in this 

appendix.

Supported M Series DAQ Devices

NI ELVIS supports the following M Series DAQ devices:

• NI 6221 (68-pin)

• NI 6225

• NI 6229

• NI 6251

• NI 6255

• NI 6259

• NI 6281

• NI 6289

Note If you are using a PCI M Series device, you must use NI ELVIS Traditional software 

version 2.0 or later. USB M Series devices require NI ELVIS Traditional 3.0 or later.

When using an M Series DAQ device with two 68-pin connectors, use 

connector 0 on the M Series DAQ device to make the connection to the 

NI ELVIS workstation.
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Supported Using E/B Series DAQ Devices

NI ELVIS supports the following E/B Series DAQ devices in addition to 

M Series DAQ devices:

• NI 6014

• NI 6024E

• NI 6036E

• NI 6040E (PCI-MIO-16E-4)

• NI 6052E

• NI 6070E (PCI-MIO-16E-1)

The Arbitrary Waveform Generator functionality of NI ELVIS is not 

available with the NI 6014, NI 6024E, or NI 6036E.

Note NI ELVIS supports all E Series devices that meet the criteria listed in the 

introduction to this appendix.

Use one of the following cables to connect the E/B Series DAQ device to 

the NI ELVIS workstation:

• SH68-68-EP

• R6868
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Table E-1 describes signals on the NI ELVIS prototype board that route 

directly to the E/B Series DAQ device. When using the NI ELVIS with an 

E/B Series DAQ device, refer to Table E-1.

PFI Signal Description
PFI—You can use these signals to supply an external source for AI, AO, DI, 

and DO timing signals or counter/timer inputs.

Table E-1.  E/B Series DAQ Device Routing

Signal Name on 

Prototype Board Direction1 E/B Series Signal Name Description2

PFI 1 Input PFI 1 Refer to the E Series User 

Manual for signal 

descriptions.
PFI 2 Input PFI 2

PFI 5 Input PFI 5

PFI 6 Input PFI 6

PFI 7 Input PFI 7

SCANCLK Output SCANCLK

RESERVED Output EXT STROBE

CTR0_SOURCE Input CTR 0 SRC

CTR0_GATE Input CTR 0 GATE

CTR0_OUTPUT Output CTR 0 OUT

CTR1_SOURCE Input CTR 1 SRC

CTR1_GATE Input CTR 1 GATE

CTR1_OUTPUT Output CTR 1 OUT

FREQ_OUT Output FREQ_OUT

1 On E/B Series DAQ devices, you can configure all of these signals as inputs or output; however, when used with the 

NI ELVIS workstation, these signals are fixed direction—either input or output.

2 Refer to the PFI Signal Description section and the E Series User Manual for more complete descriptions of these signals.
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F
Using Bypass Communication 
Mode

This appendix describes the function of the Communications switch on the 

NI ELVIS workstation front panel. In most applications, set the 

communications switch to Normal.

The following DAQ device functions are routed directly to the prototyping 

board:

• Analog input

• Analog output

• Counter I/O

You can access these functions directly, regardless of the position of the 

communications switch, by using the native NI-DAQmx functions 

supported by the DAQ device. Refer to the NI-DAQmx Help for more 

information.

When the Variable Power Supply and Function Generator are switched to 

Manual mode, they are controlled directly by the controls on the NI ELVIS 

workstations and are not affected by the position of the communications 

switch.

Normal Mode

When the communications switch on the NI ELVIS workstation is set to 

Normal, the digital I/O lines of the DAQ device are used for communicating 

to the NI ELVIS workstations and controlling its instruments from 

software. All NI ELVIS Traditional software functionality is available 

when the communications switch is set to Normal.

In Normal mode, the DI and DO digital ports are accessed using the 

NI ELVIS DIO functions.
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Bypass Mode

When the NI ELVIS workstation is set to Bypass mode, the eight digital I/O 

lines on Port 0 of the DAQ device are routed directly to DI <0..7> on the 

NI ELVIS prototyping board. In order to enable Bypass Mode, you must 

first set the communications switch on the NI ELVIS workstation to 

Bypass, and then execute the NI ELVIS Traditional - Enable 

Communications Bypass VI from LabVIEW. Figure F-1 shows the VI.

Figure F-1.  NI ELVIS Traditional - Enable Communications Bypass VI

To access the DAQ device Digital I/O lines after enabling Bypass mode, 

you must use the NI-DAQmx Digital I/O functions. Information about 

using these functions is available in the NI-DAQmx Help.

When the communications switch is set to Bypass mode, communication to 

the NI ELVIS workstation is disabled, therefore most NI ELVIS 

Traditional software functionality is unavailable in Bypass mode.



© National Instruments Corporation G-1 NI ELVIS Hardware User Manual

G
Common Questions

This appendix lists common questions related to the use of the NI ELVIS 

workstation.

Can I use the NI ELVIS Traditional SFP and the NI ELVIS Traditional 

API at the same time?

No. Due to software conflicts you can only use one at a time. In order to use 

the LabVIEW API, you must first close the ELVIS Traditional SFP.

When using the current DMM function, why are measurements made 

at the positive side of the circuit less accurate than measurements made 

on the grounded side?

The ELVIS DMM has limited common-mode rejection capabilities. For 

optimal accuracy, make current measurements on the grounded side of the 

circuit.

Can I use multiple NI ELVIS Workstations on one computer?

NI ELVIS Traditional version 2.0.5 added the ability to open multiple 

simultaneous sessions of the NI ELVIS Traditional Instrument Launcher 

that you can use to control multiple NI ELVIS workstations. This assumes 

that each workstation is connected to a separate DAQ device. Each time you 

open the NI ELVIS Traditional executable a new session is instantiated, so 

you can have a single session open for each workstation. Once you open the 

NI ELVIS Traditional Instrument Launcher, click the Configure button 

to set both Instrument Launchers to use different DAQ devices for 

communication. The NI ELVIS Traditional LabVIEW API currently does 

not support using multiple NI ELVIS workstations on the same computer.

Where can I find additional NI ELVIS resources for professors or 

students?

There are a number of resources for professors and students using 

NI ELVIS available at ni.com/academic.



Appendix G Common Questions

NI ELVIS Hardware User Manual G-2 ni.com

Can I use the digital I/O lines on the second connector of a M Series 

DAQ device without interfering with NI ELVIS?

If you use an M Series DAQ device with additional DIO functionality on 

the second connector with NI ELVIS, only port 0 of the DAQ device is 

reserved for NI ELVIS. You can use the rest of the ports without a problem.
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Glossary

Symbol Prefix Value

p pico 10–12

n nano 10–9

μ micro 10– 6

m milli 10–3

k kilo 103

M mega 106

Symbols

% Percent.

– Negative of, or minus.

+ Positive of, or plus.

/ Per.

° Degree.

Ω Ohm.

± Plus or minus.

√ Square root.

A

A Amperes.

AC Alternating current.

ACH Analog input channel signal.

ADDRESS The DIO output signals of the address bus.
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AI Analog input.

AI GND Analog input ground signal.

AI SENSE Analog input sense signal.

AM Amplitude modulation—the process in which the amplitude of a carrier 

wave is varied to be directly proportional to the amplitude of the 

modulating signal.

AM IN Amplification modulation input signal.

amplification A type of signal conditioning that improves accuracy in the resulting 

digitized signal and reduces noise.

amplitude The voltage amplitude of a signal. When speaking of the amplitude of a 

signal, it is usually assumed to be the RMS value for an AC signal. 

However, amplitude can also refer to the instantaneous amplitude, or the 

peak, peak-to-peak, or average amplitude, if so specified.

AO Analog output.

ARB Arbitrary waveform generator.

B

block diagram Pictorial description or representation of a program or algorithm. The block 

diagram, consists of executable icons called nodes and wires that carry data 

between the nodes. The block diagram is the source code for the VI. The 

block diagram resides in the block diagram window of the VI.

BNC A type of coaxial signal connector.

bode plot The plot of the gain and phase of a system as a function of frequency.

bus The group of conductors that interconnect individual circuitry in a 

computer. Typically, a bus is the expansion vehicle to which I/O or other 

devices are connected. An example of a PC bus is the PCI bus.
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C

C Celsius.

capacitance The ability to hold an electrical charge.

CH Channel.

channel Pin or wire lead to which you apply or from which you read the analog or 

digital signal. Analog signals can be single-ended or differential. For digital 

signals, you group channels to form ports. Ports usually consist of either 

four or eight digital channels.

counter/timer A circuit that counts external pulses or clock pulses (timing).

CTR0_GATE Counter 0 gate signal.

CTR0_OUT Counter 0 output signal.

CTR0_SOURCE Counter 0 source signal.

CTR1_GATE Counter 1 gate signal.

CTR1_OUT Counter 1 output signal.

CURRENT Input signals for current-related measurements for the DMM.

D

D/A Digital-to-analog.

DAC D/A converter.

DAQ Data acquisition.

dB Decibel—the unit for expressing a logarithmic measure of the ratio of 

two signal levels: dB = 20log10 V1/V2, for signals in volts.

DC Direct current.

default setting A default parameter value recorded in the driver. In many cases, the default 

input of a control is a certain value (often 0) that means use the current 

default setting.
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DI Digital I/O input signals sent to the DI bus.

differential input An analog input consisting of two terminals, both of which are isolated 

from computer ground, whose difference is measured.

digital trigger A TTL level signal having two discrete levels—a high level and a low level.

DIO Digital I/O.

diode A specialized electronic component with two electrodes called the anode 

and the cathode.

DMM Digital multimeter.

DO Digital I/O output signals from the DO bus.

DOC Canadian Department of Communications.

DSA Dynamic signal analyzer.

DUT Device under test.

E

ECG Electrocardiogram.

EEPROM Electrically erasable programmable read-only memory—ROM that can be 

erased with an electrical signal and reprogrammed.

ELVIS Educational Laboratory Virtual Instrumentation Suite.

EMC Electromechanical compliance.

EMI Electromagnetic interference.

EXTSTROBE External strobe signal.

F

FCC Federal Communications Commission.

FGEN Function generator.
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floating signal sources Signal sources with voltage signals that are not connected to an absolute 

reference or system ground. Also called nonreferenced signal sources. 

Some common example of floating signal sources are batteries, 

transformers, or thermocouples.

FM_IN Frequency modulation input signal.

FREQ_OUT Frequency output signal.

frequency The basic unit of rate, measured in events or oscillations per second using 

a frequency counter or spectrum analyzer. Frequency is the reciprocal of 

the period of a signal.

front panel The user interface of a LabVIEW virtual instrument.

FUNC_OUT Output signal for the function generator.

G

gain The factor by which a signal is amplified, sometimes expressed in decibels.

GPCTR0_GATE General-purpose counter timer 0 gate signal, available from a DAQ device.

GPCTR0_OUT General-purpose counter timer 0 output signal, available from a DAQ 

device.

GPCTR0_SOURCE General-purpose counter timer 0 clock source signal, available from a 

DAQ device.

GPCTR1_GATE General-purpose counter timer 1 gate signal, available from a DAQ device.

GPCTR1_OUT General-purpose counter timer 1 output signal, available from a 

DAQ device.

GPCTR1_SOURCE General-purpose counter timer 1 clock source signal, available from a 

DAQ device.

GROUND Prototyping board ground signal.



Glossary

NI ELVIS Hardware User Manual Glossary-6 ni.com

H

hardware triggering A form of triggering where you set the start time of an acquisition and 

gather data at a known position in time relative to a trigger signal.

Hz Hertz—the number of scans read or updates written per second.

I

I/O Input/output—the transfer of data to/from a computer system involving 

communications channels, operator interface devices, and/or data 

acquisition and control interfaces.

in. Inch or inches.

impedance The electrical characteristic of a circuit expressed in ohms and/or 

capacitance/inductance. 

inductance The characteristic of a coil that generates a voltage due to changes in the 

current. An inductor creates a voltage that is the derivative of the current, 

while a capacitor creates a voltage that is the integral of the current.

J

JFET Junction Field Effect Transistor. A three-terminal semiconductor device 

constructed with a PN junction at its input and a conducting channel as the 

output section. The PN junction of the input section is reverse biased to 

provide an extremely high input resistance.

L

LabVIEW A graphical programming language.

LATCH DIO output signal that pulses when data is ready on the write bus.

LED Light-emitting diode.
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N

NI-DAQ National Instruments driver software for DAQ hardware.

NI-DAQmx The latest NI-DAQ driver with new VIs, functions, and development tools 

for controlling measurement devices. 

NPN transistor A two-junction (bipolar) semiconductor transistor with an N-type (negative 

ion) collector and emitter and a P-type (positive ion) base. An NPN 

transistor is created by adding a thin layer of P-type semiconductor material 

between two regions of N-type material.

NRSE Nonreferenced single ended mode—all measurements are made with 

respect to a common (NRSE) measurement system reference, but the 

voltage at this reference can vary with respect to the measurement system 

ground.

O

op-amp Operational amplifier—pre-built amplifier modules that are general 

enough to be used almost anywhere an amplifier is needed.

P

PCB Printed circuit board.

PCI Peripheral Component Interconnect—a high-performance expansion bus 

architecture originally developed by Intel to replace ISA and EISA. It is 

achieving widespread acceptance as a standard for PCs and workstations; 

it offers a theoretical maximum transfer rate of 132 Mbytes/s.

peak-to-peak A measure of signal amplitude; the difference between the highest and 

lowest excursions of the signal.

PFI Programmable function input.

PN The simplest semiconductor structure. It consists of a positive or P-region 

(containing positive ions) in junction with a negative or N-region 

(containing negative electrons).
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R

RD_ENABLE Read enable signal—DIO output signal that indicates when data is being 

read from the read bus.

referenced signal

sources

Signal sources with voltage signals that are referenced to a system ground, 

such as the earth or a building ground. Also called grounded signal sources.

resistance The resistance to the flow of electric current. One ohm (Ω) is the resistance 

through which one volt of electric force causes one ampere to flow.

rms Root mean square.

S

s Seconds.

S Samples.

S/s Samples per second—used to express the rate at which a DAQ device 

samples an analog signal.

SCANCLK Scan clock signal.

Scope Abbreviation for oscilloscope.

SFP Soft front panel.

SYNC_OUT TTL signal of the same frequency of the function generator.

T

TIO Timing I/O.

TRIG Trigger signal.

trigger Any event that causes or starts some form of data capture.

TRIGGER Trigger input signal for the oscilloscope.

TTL Transistor-to-transistor logic.
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V

V Volt or volts.

VI Virtual instrument—a combination of hardware and/or software elements, 

typically used with a PC, that has the functionality of a classic stand-alone 

instrument.

VOLTAGE Input signals for the DMM voltmeter.

Vp-p Peak-to-peak voltage.

W

waveform Multiple voltage readings taken at a specific sampling rate.

WR_ENABLE DIO output signal that indicates data is being written to the write bus.
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Index

Symbols
+5 V

+5 V power supply

prototyping board power, 3-7

specifications, A-3

+5V signal

See also DC power supplies

connecting analog output signals, 3-15

signal description (table), 3-9

fuse (figure), B-3

±15 V

–15 V signal

See also DC power supplies

signal description (table), 3-9

+15 V signal

See also DC power supplies

connecting analog output signals, 3-15

signal description (table), 3-9

±15 V power supply

prototyping board power, 3-7

specifications, A-2

–15 V signal

connecting analog output signals, 3-15

fuses (figure), B-3

Numerics
3-WIRE signal

See also DMM

connecting analog input signals, 3-14

fuse (figure), B-3

signal description (table), 3-8

three-wire current-voltage analyzer theory 

of operation, C-13

A
academic use of NI ELVIS, 2-10, 2-11

ACH<0..5>– signals

analog input signal mapping (table), 3-12

signal description (table), 3-8

ACH<0..5>+ signals

analog input signal mapping (table), 3-12

signal description (table), 3-8

ADDRESS <0..3> signals

See also digital I/O

resistor pack, B-4

signal description (table), 3-10

AI GND signal

analog input signal mapping (table), 3-12

connecting analog input signals, 3-12

signal description (table), 3-8

AI SENSE signal

analog input signal mapping (table), 3-12

connecting analog input signals, 3-12

resistor pack, B-4

signal description (table), 3-8

AM_IN signal

See also function generator

connecting analog output signals, 3-15

resistor pack, B-4

signal description (table), 3-9

analog input

connecting signals, 3-12

resistor packs, B-4

resource conflicts, 3-13

signal mapping (table), 3-12

software instruments

bode analyzer SFP, 2-5

DMM SFP, 2-5

DSA SFP, 2-6

impedance analyzer SFP, 2-6

scope SFP, 2-6
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three-wire current-voltage analyzer 

SFP, 2-7

two-wire current voltage analyzer 

SFP, 2-7

analog output

connecting signals, 3-14

hardware instruments

function generator

controls, 3-3

overview, 2-2

variable power supplies

controls, 3-3

overview, 2-2

software instruments

ARB SFP, 2-4

FGEN SFP, 2-6

variable power supplies, 2-7

theory of operation, C-15

API, overview, 2-8

ARB

resource conflicts (table), D-2

SFP overview, 2-4

theory of operation, C-15

B
BANANA <A..D> signals

connecting user configurable I/O 

signals, 3-16

connector locations (figure), 3-7

signal description (table), 3-9

benchtop workstation

controls and indicators, 3-2

overview, 2-2

parts locator diagram, 3-2

removing protection board, B-1

theory of operation, C-1

BNC <1..2>– signals

connecting user configurable I/O 

signals, 3-16

signal description (table), 3-9

BNC <1..2>+ signals

connecting user configurable I/O 

signals, 3-16

signal description (table), 3-9

bode analyzer

resource conflicts (table), D-2

SFP overview, 2-5

specifications, A-2

bypass mode

communications switch

location (figure), 3-2

overview, 3-2

C
calibration utility, 2-9

CH <A..B>– signals

See also oscilloscope

signal description (table), 3-8

CH <A..B>+ signals

See also oscilloscope

connecting analog input signals, 3-14

signal description (table), 3-8

communications switch

location (figure), 3-2

overview, 3-2

configuring NI ELVIS, 2-4

conflicts, resources (table), D-1

connecting signals on the prototyping board

analog input

DMM, 3-14

generic analog input, 3-12

grounding, 3-12

oscilloscope, 3-14

resource conflicts

overview, 3-13

table, D-2

analog output

DC power supplies, 3-15

function generator, 3-15

generic analog output, 3-14
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variable power supplies, 3-15

counter/timer signals, 3-16

digital I/O, 3-16

user-configurable signals, 3-16

connectors. See I/O connectors

conventions used in the manual, iv

counter/timers

connecting signals, 3-16

resistor pack, B-4

resource conflicts (table), D-2

CURRENT HI signal

See also DMM

connecting analog input signals, 3-14

fuses (figure), B-3

signal description (table), 3-8

theory of operation

DMM, C-3

impedance analyzer, C-8

three-wire current-voltage 

analyzer, C-13

two-wire current-voltage 

analyzer, C-12

CURRENT LO signal

See also DMM

connecting analog input signals, 3-14

fuses (figure), B-3

impedance analyzer theory of operation 

(figure), C-9

signal description (table), 3-8

theory of operation

DMM, C-3

three-wire current-voltage 

analyzer, C-13

two-wire current-voltage 

analyzer, C-12

D
DAC<0..1> signals

See also analog output

connecting analog output signals, 3-14

fuses (figure), B-3

internally using (caution), 3-14

signal description (table), 3-8

theory of operation

three-wire current-voltage 

analyzer, C-13

two-wire current-voltage 

analyzer, C-12

DAQ hardware

definition, 1-2

NI ELVIS components (figure), 2-1, 2-2

overview, 1-3

resource conflicts (table), D-2

theory of operation, C-1

DC power supplies

prototyping board power, 3-7

signal descriptions (table), 3-9

specifications

+5 V power supply, A-3

±15 V supply, A-2

debugging the protection board, B-2

DI <0..7> signals

See also digital I/O

connecting digital I/O signals, 3-16

signal description (table), 3-10

digital bus reader SFP, 2-5

digital bus writer SFP, 2-5

digital I/O

connecting signals, 3-16

resistor packs, B-4

resource conflicts, D-1

signal descriptions (table), 3-9, 3-10

software instruments

digital bus reader, 2-5

digital bus writer SFP, 2-5

digital multimeter. See DMM

DMM

connecting signals, 3-14

connectors

description, 3-4

location (figure), 3-2
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internally using the DACs (caution), 3-14

overview, 2-5

resource conflicts (table), D-2

signal descriptions (table), 3-8

specifications

current measurement, A-4

voltage measurement, A-5

theory of operation, C-1

DO <0..7> signals

See also digital I/O

connecting digital I/O signals, 3-16

signal description (table), 3-9

documentation

conventions used in the manual, iv

related documentation, 1-6

DSA

resource conflicts (table), D-2

SFP overview, 2-6

DSUB PIN signals

signal description (table), 3-10

DSUB SHIELD signal

signal description (table), 3-10

dynamic signal analyzer. See DSA

E
electromagnetic compatibility 

specifications, A-9

ELVIS. See NI ELVIS

F
FGEN. See function generator

FM_IN signal

See also function generator

connecting analog output signals, 3-15

signal description (table), 3-9

FUNC_OUT signal

See also function generator

connecting analog output signals, 3-15

resistor pack, B-4

signal description (table), 3-9

function generator

calibration utility, 2-9

connecting signals, 3-15

hardware

controls description, 3-3

controls location (figure), 3-2

overview, 2-6

resource conflicts (table), D-2

signal descriptions (table), 3-9

specifications, A-6

theory of operation, C-6

fuses

debugging the protection board, B-2

location (figure), B-3

G
GLB_RESET signal

See also digital I/O

signal description (table), 3-9

GROUND signal

See also DC power supplies; variable 

power supplies

connecting analog output signals, 3-15

signal description (table), 3-9

H
hardware

connecting signals, 3-11

DAQ

definition, 1-2

overview, 1-3

fuses, B-1, B-3

installation documentation, 1-1

NI ELVIS components

benchtop workstation, 3-2

DAQ device, 3-1

overview (figure), 2-1, 2-2

protection board, 3-6
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prototyping board, 3-6

resource conflicts (table), D-2

specifications, A-1

theory of operation, C-1

I
I/O connectors

I/O connector descriptions, 3-16

location (figure), 3-7

signal descriptions (table), 3-8

impedance analyzer

resource conflicts (table), D-2

SFP overview, 2-6

theory of operation, C-7

installation documentation location, 1-1

instrument launcher, 2-4

instrumentation, virtual, 1-1

L
LabVIEW

NI ELVIS Traditional software 

instruments, 2-3

overview, 1-3

virtual instrumentation, 1-1

LATCH signal

See also digital I/O

signal description (table), 3-9

launcher, instrument, 2-4

LED <0..7> signals

connecting user configurable I/O 

signals, 3-17

signal description (table), 3-10

N
NI ELVIS

components (figure), 2-1, 2-2

configuring, 2-4

hardware overview, 2-2

instrument launcher, 2-4

LabVIEW API, 2-8

overview, 1-5

benchtop workstation, 2-2

DAQ hardware, 1-3

LabVIEW, 1-3

prototyping board, 2-3

parts locator diagram, 2-1, 2-2

software overview, 2-3

theory of operation, C-1

using in academic disciplines, 2-10, 2-11

O
oscilloscope

connectors (figure), 3-2

connectors on benchtop workstation, 3-4

overview, 2-6

resource conflicts

overview, 3-13

table, D-2

signal descriptions (table), 3-8

specifications, A-6

P
power supply

DC. See DC power supply

prototyping board, 3-7

variable. See variable power supplies

programmable function I/O

resistor pack, B-4

protection board

debugging, B-2

overview, 3-6

reinstalling, B-4

removing the protection board, B-1

theory of operation, C-1

prototyping board

connecting signals

analog input
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DMM, 3-14

generic analog input, 3-12

grounding, 3-12

oscilloscope, 3-14

resource conflicts

overview, 3-13

table, D-2

analog output

DC power supplies, 3-15

function generator, 3-15

generic analog output, 3-14

variable power supplies, 3-15

counter/timer signals, 3-16

digital I/O, 3-16

overview, 2-3, 3-6

parts locator diagram, 3-7

power

supply, 3-7

switch (figure), 3-2

signal descriptions (table), 3-8

theory of operation, C-1

R
RD_ENABLE signal

See also digital I/O

signal description (table), 3-9

related documentation, 1-6

removing protection board, B-1

resistor packs

location (figure), B-3

NI ELVIS components (table), B-4

resource conflicts (table), D-1

S
safety specifications, A-8

SCANCLK signal

resistor pack, B-4

Scope. See oscilloscope

SFP instruments

ARB, 2-4

bode analyzer, 2-5

digital bus reader SFP, 2-5

digital bus writer, 2-5

DMM, 2-5

DSA, 2-6

FGEN, 2-6

impedance analyzer, 2-6

instrument launcher, 2-4

overview, 2-3

resource conflicts (table), D-2

Scope, 2-6

three-wire current-voltage analyzer, 2-7

two-wire current voltage analyzer, 2-7

variable power supplies, 2-7

signal descriptions (table), 3-8

specifications

analog input, A-1

bode analyzer, A-2

DC power supplies

+5 V supply, A-3

±15 V supply, A-2

DMM

current measurement, A-4

voltage measurement, A-5

electromagnetic compatibility, A-9

function generator, A-6

oscilloscope, A-6

safety, A-8

variable power supplies

negative supply, A-7

positive supply, A-7

SUPPLY– signal

See also variable power supplies

connecting analog output signals, 3-15

signal description (table), 3-9

SUPPLY+ signal

See also variable power supplies

signal description (table), 3-9
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SYNC_OUT signal

See also function generator

connecting analog output signals, 3-15

resistor pack, B-4

signal description (table), 3-9

system power LED (figure), 3-2

T
three-wire current-voltage analyzer

resource conflicts (table), D-2

SFP overview, 2-7

theory of operation, C-13

TRIGGER signal

See also oscilloscope

signal description (table), 3-8

two-wire current-voltage analyzer

resource conflicts (table), D-2

SFP overview, 2-7

theory of operation, C-12

U
user-configurable I/O

BANANA signals, 3-9

BNC <1..2>– signals, 3-9

BNC <1..2>+ signals, 3-9

connecting signals, 3-16

DSUB pin <0..9> signals, 3-10

DSUB shield, 3-10

LED <0..7> signals, 3-10

V
variable power supplies

calibration utility, 2-9

fuses (figure), B-3

hardware controls

description, 3-3

figure, 3-2

overview, 2-7

resource conflicts, D-1

signal descriptions (table), 3-9

specifications

negative supply, A-7

positive supply, A-7

virtual instrumentation, 1-1

VOLTAGE HI signal

See also DMM

connecting analog input signals, 3-14

DMM theory of operations, C-1

signal description (table), 3-8

VOLTAGE LO signal

See also DMM

connecting analog input signals, 3-14

DMM theory of operations, C-1

signal description (table), 3-8

W
WR_ENABLE signal

See also digital I/O

signal description (table), 3-9
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